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1. Click the Find button (Binoculars), or choose Edit > Find.
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Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

            Choose Edit > Find Again 

            Reopen the find dialog box, and click Find Again. 
            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.
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1. Select the text tool T, and do one of the following:
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       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[There is no reportable action as a result of the

Board of Supervisors' closed session held today.]
SUP. ANTONOVICH, MAYOR: OKAY. WE'LL BEGIN THE FEBRUARY 17TH MEETING OF THE LOS ANGELES COUNTY BOARD OF SUPERVISORS. FIRST WE'LL BE LED IN PRAYER BY PASTOR DENNIS SCHREIBER OF THE BETHANY CHURCH OF ALHAMBRA. THE PLEDGE OF ALLEGIANCE BY NELLY PADILLA MACIAS, FORMER SERGEANT, UNITED STATES ARMY OF THE THIRD SUPERVISORIAL DISTRICT. PASTOR? 

PASTOR DENNIS SCHREIBER: WELL FATHER GOD WE JUST COME BEFORE YOU RIGHT NOW AND WE BEGIN BY SAYING THANK YOU. BECAUSE YOU HAVE RAISED US TO BE GRATEFUL PEOPLE. AND SO WE JUST GIVE YOU GLORY AND WE GIVE YOU PRAISE FOR ALL THE BLESSINGS THAT YOU'VE GIVEN TO US. AND YOU'VE GIVEN US GREAT BLESSINGS AND WE'RE THANKFUL FOR THAT. WE DON'T HAVE EVERYTHING WE NEED, BUT WE HAVE MUCH. AND SO WE JUST BEGIN BY SAYING WE'RE GRATEFUL. LORD, WE ALSO COME TO YOU RIGHT NOW AND WE ASK THAT AS THIS BUSINESS MEETING BEGINS AND ALL THE WORK THAT HAS TO BE DONE BY THESE THAT HAVE GATHERED HERE, LORD, WE PRAY FOR WISDOM. WE PRAY FOR GUIDANCE. WE PRAY FOR A DIVINE UNDERSTANDING ON ALL THE ISSUES THAT ARE BEFORE THESE SERVANTS THAT HAVE GATHERED HERE, LORD. WE JUST PRAY THAT YOU WOULD GIVE THEM THE RIGHT ANSWER, THE WORK THAT'S BEFORE THEM, LORD, WOULD COME WITH GREAT JOY AND WITH GOOD WISDOM, LORD, THE RIGHT DECISIONS. LORD, THIS AFTERNOON, LORD, I JUST WANT TO ALSO PRAY FOR THOSE THAT HAVE GATHERED, LORD. I JUST PRAY A SPECIAL BLESSING ON THEM. THERE ARE SOME THAT ARE HERE THIS AFTERNOON, THAT JUST NEED A TOUCH IN THEIR LIFE, LORD, THEY NEED MAYBE EVEN A HEALING IN THEIR BODY. THEY NEED YOU TO TOUCHDOWN AND JUST STRENGTHEN THEM. LORD, I PRAY FOR THE BOARD THAT'S GATHERED HERE, I PRAY FOR A BLESSING IN THEIR LIVES, I PRAY THAT YOU WOULD FILL THEM WITH JOY, YOU WOULD FILL THEM WITH JUST LIFE ITSELF. AND, LORD, I PRAY A SPECIAL BLESSING ALSO UPON THEIR FAMILIES. THE STRAIN OF WHAT THEY DO, LORD, AND HOW IT CARRIES OUT INTO THEIR FAMILIES, I PRAY BLESSING UPON THEIR FAMILIES. LORD, I PRAY BLESSING UPON OUR GREAT COUNTY, LORD. WHAT A. GREAT PLACE YOU'VE GIVEN US TO LIVE IN. WE'RE GRATEFUL TO YOU, LORD. AGAIN, BLESS THIS TIME, BLESS THIS DAY, BLESS THIS COUNTY, IN YOUR NAME WE PRAY, AMEN. 

SPEAKER: PLEASE REMAIN STANDING AND JOIN ME IN THE PLEDGE OF ALLEGIANCE. [PLEDGE OF ALLEGIANCE RECITED.] 

SUP. ANTONOVICH, MAYOR: ONCE AGAIN, PASTOR DENNIS SCHREIBER CURRENTLY SERVES AS THE LEAD PASTOR OF THE BETHANY CHURCH OF ALHAMBRA, A GRADUATE OF VANGUARD UNIVERSITY AND AN ORDAINED MINISTER FROM THE ASSEMBLIES OF GOD. HE HAS SERVED IN A VARIETY OF MINISTRY CAPACITIES FOR 40 YEARS, THE MAJORITY OF HIS MINISTRIES TAKING PLACE IN THE GREATER LOS ANGELES AREA, LOMITA, GRENADA HILLS AND ARTESIA. HE ALSO SITS ON THE EXECUTIVE BOARD OF THE GLOBAL AIM U.S.A. A MINISTRY TO ASIAN INDIANS IN THE UNITED STATES. THANK YOU, PASTOR, FOR COMING DOWN. THAT WAS NOT NELLY LEADING US IN THE PLEDGE. THANK YOU. 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: GOOD AFTERNOON, MR. MAYOR AND MEMBERS OF THE BOARD, WE WILL BEGIN ON PAGE 3 AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEMS 1-D THROUGH 4-D. ON ITEM 1-D AND 2-D, A MEMBER OF THE PUBLIC REQUESTS THAT THESE ITEMS BE HELD. THE REMAINING ITEMS UNDER THE COMMUNITY DEVELOPMENT COMMISSION ARE FOR YOU. 

SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR HILDA SOLIS, SECOND WITHOUT OBJECTION, SO ORDERED. 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: ON PAGE 6, AN AGENDA FOR THE MEETING OF THE REGIONAL PARK AND OPEN SPACE DISTRICT. ITEM 1-P IS BEFORE YOU. 

SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR KNABE. SECOND WITHOUT OBJECTION, SO ORDERED. 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: ON PAGE 7, BOARD OF SUPERVISORS, ITEMS 1 THROUGH 7. ON ITEM NO. 1, THIS INCLUDES THE ADDITION AS POSTED ON THE SUPPLEMENTAL AGENDA. ON ITEM NO. 2, SUPERVISOR SOLIS AND KNABE AND A MEMBER OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. ON ITEM NO. 3, SUPERVISOR SOLIS REQUESTS THAT THIS ITEM BE HELD. ON ITEM NO. 5, A. MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD AND ON ITEM NO. 7, A. MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. THE REMAINING ITEMS UNDER THE BOARD OF SUPERVISORS ARE BEFORE YOU. 

SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR KUEHL, SECOND IT WITHOUT OBJECTION, SO ORDERED. 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: ON PAGE 10 CONSENT CALENDAR, ITEMS 8 THROUGH 31. ITEM 9, A MEMBER OF THE PUBLIC REQUESTS THAT THIS ITEM BE HELD. ON ITEM NO. 13, SUPERVISOR ANTONOVICH REQUESTS THAT THIS ITEM BEING CONTINUED ONE WEEK TO FEBRUARY 24, 2015. ON ITEM NUMBER 14 SUPERVISORS ANTONOVICH AND MEMBERS OF THE PUBLIC REQUEST THAT AN ITEM BE HELD. ON ITEM NO. 16, MEMBERS OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. ON ITEM NO. 27, MEMBERS OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. AND THE REMAINING ITEMS ON THE CONSENT CALENDAR ARE BEFORE YOU. 

SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR SOLIS, SECOND, WITHOUT OBJECTION, SO ORDERED. 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: ON PAGE 23, ORDINANCES FOR INTRODUCTION, ON ITEMS 32 AND 33. ON ITEM 32 THIS IS AN ORDINANCE FOR INTRODUCTION AMENDING COUNTY CODE TITLE 2 ADMINISTRATION RELATING TO THE SMALL CRAFT HARBORS DESIGN CONTROL BOARD TO EXTEND THE SUNSET REVIEW DATE FOR THE DESIGN CONTROL BOARD TO MARCH 31, 2019. ON THIS ITEM, THERE'S A MEMBER OF THE PUBLIC THAT REQUESTED THIS ITEM BE HELD. ON ITEM NUMBER 33, SUPERVISOR ANTONOVICH REQUESTS THAT THIS ITEM BE HELD. I'M SORRY. THAT IT BE CONTINUED ONE WEEK TO FEBRUARY 24, 2015. ON PAGE 24, DISCUSSION ITEMS 34 THROUGH 36, THESE ITEMS WILL BE HELD FOR DISCUSSION. AND THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS SPECIAL ITEMS BEGIN WITH SUPERVISORIAL DISTRICT NO. 5. 

SUP. ANTONOVICH, MAYOR: FIRST WE WANT TO WELCOME BILL FENNESSY, PARKS AND RECREATIONS GOLF ADVISORY COMMITTEE FOR THE PAST 12 YEARS. DURING HIS TENURE HE OVERSAW THE GROWTH OF THE FIRST TEE OF PASADENA GOLF PROGRAM WHICH SERVES THOUSANDS OF YOUNG GOLFERS. IN ADDITION TO TEACHING YOUNG KIDS ON HOW TO GOLF THE PROGRAM TEACHERS NINE CORE VALUES INCLUDING INTEGRITY, SPORTSMANSHIP, RESPECT, CONFIDENCE, RESPONSIBILITY, PERSEVERANCE, COURTESY, HONESTY AND GOOD JUDGMENT. HIS MOTHER, JACKIE, WAS A. LONG- TIME MEMBER OF THE ALTADENA TOWN COUNCIL, A REALLY GOOD FRIEND, GOOD COMMUNITY LEADER. BILL WITH HIM TODAY IS HIS WIFE AKANYA, CRAIG KESSLER, DIRECTOR OF GOVERNMENT AFFAIRS FOR THE SOUTHERN CALIFORNIA GOLF ASSOCIATION. JORJE BIDEL, SENIOR GOLF DIRECTOR, BOB BADEREAN, EXECUTIVE DIRECTOR OF THE FIRST TEE OF PASADENA. WARREN LARRY, GOLF DIRECTOR AND JOHN WICKER, CHIEF DEPUTY FOR OUR PARKS AND RECREATION. HE HAD A WONDERFUL MOTHER, A WONDERFUL FAMILY, IT'S GOOD TO SEE YOU. CONGRATULATIONS. 

BILL FENNESSY: SUPERVISOR ANTONOVICH, THANK YOU VERY MUCH FOR THIS WONDERFUL AWARD. I DO WANT TO SAY THAT I'M FORTUNATE ENOUGH TO WORK WITH A LOT OF GREAT PEOPLE IN THE COUNTY IN GOLF ADVISORY COMMITTEE. RUSS GUINEY, JOHN WICKER AND CANDY HAYES, THEIR SUPPORT OF GEORGE BIDEL, WARREN LARRY, TIM SMITH, MIKE MCMONNAGLE AND TUFIK DOWN AT GOLF OPERATIONS. REALLY A GREAT EXERCISE IN VOLUNTEER SERVICE IN THE PUBLIC SECTOR TO HELP THE GOLF COMMUNITY. SO THANK YOU ALL VERY MUCH. [APPLAUSE.] 

SPEAKER: GOOD AFTERNOON, EVERYBODY. THANK YOU, SUPERVISOR. WELL, FIRST OF ALL, THANK YOU TO BILL FOR ALL OF HIS CONTRIBUTIONS TO THE COMMUNITIES THAT WE SERVE. THANK YOU TO HIS WIFE LACONIA, FOR ALLOWING US TO BORROW BILL AND ALLOWING HIM TO SPEND SO MUCH TIME WITH US. I WANT TO TELL YOU A LITTLE BIT ABOUT BILL, TOO. HE BEGAN PLAYING AT THE ALTADENA GOLF COURSE WHEN HE WAS ONLY 13 YEARS OLD. AND HE STARTED TO WORK THERE AT THE COURSE JUST SHORTLY AFTER THAT. HE JOINED HIS HIGH SCHOOL GOLF TEAM AND ENTERED THE MEN'S CLUB AND ALSO THE REGIONAL COMPETITIONS. HE FEELS HE OWES SOME OF HIS PERSONAL DEVELOPMENT TO HIS PARTICIPATION IN THE GOLF PROGRAM IN HIS YOUTH. BECAUSE OF THIS, HE NOW PROMOTES GOLF AS A GREAT TOOL THAT CAN TEACH KIDS VALUABLE LIFE SKILLS LIKE PROPER INTRODUCTIONS, MANAGING EMOTIONS AND RESOLVING CONFLICTS. ONE AFTERNOON, BILL WAS TALKING TO A GIRL THAT WAS ABOUT EIGHT YEARS OLD WHO WAS PARTICIPATING IN OUR FIRST TEE PROGRAM. SHE ASKED BILL IF HE HAD BEEN AT FIRST TEE WHEN HE WAS A KID. HE TOLD HER THAT FIRST TEE DIDN'T EXIST WHEN HE WAS YOUNG AND THAT AND KIDS TODAY ARE LUCKY TO TAKE ADVANTAGE OF IT. SHE PAUSED AND THEN ASKED, "IS THAT WHY SOME PEOPLE DON'T PRACTICE GOOD LIFE SKILLS?" HE REPLIED "IT COULD BE. DO YOU THINK FIRST TEE COULD HAVE HELPED THEM?" "YES," SHE SAID AND SHE ADDED "I'M SURE GLAD THAT I'M NOT OLD." BILL GETS GREAT SATISFACTION IN KNOWING HIS CONTRIBUTIONS HELP BOTH YOUNG PEOPLE AND ADULTS ENJOY THE INCREDIBLE BENEFITS OF THE GREAT GAME OF GOLF. AND ONE PIECE OF ADVICE HE GIVES IS SIMPLE: KEEP PLAYING. CONGRATULATIONS, BILL, AND THANK YOU FOR ALL YOU DO. [APPLAUSE.] 

SUP. ANTONOVICH, MAYOR: TODAY WE'RE GOING TO RECOGNIZE GERALDO RODRIGUEZ FOR HIS 40 YEARS OF SERVICE TO OUR COUNTY OF LOS ANGELES. HE BEGAN HIS CAREER BACK IN 1974 WITH THE PROBATION DEPARTMENT, LATER AS A PROGRAM DIRECTOR FOR THE COUNTY'S COMMUNITY AND SENIOR SERVICES DEPARTMENT. DURING HIS CAREER HE DESIGNED PROGRAMS TO IMPROVE THE QUALITY OF LIFE OF COUNTY RESIDENTS INCLUDING THE COUNTY'S MEDIATION PROGRAM AND THE EMERGENCY PANTRY. SO WITH HIM TODAY IS CYNTHIA BANKS, DIRECTOR OF OUR COMMUNITY SOCIAL SERVICES AND THE PROCLAMATION THAT WE'RE GOING TO GIVE YOU FOR 40 YEARS. NOW, WHEN YOU COME BACK FOR 80 YEARS, WE'LL HAVE A BIG ONE FRAMED. [LAUGHTER.] [APPLAUSE.] 

GERALDO RODRIGUEZ: WELL, THANK YOU VERY MUCH. THIS IS REALLY AN HONOR TO BE UP HERE. I'VE BEEN AROUND FOR A LONG TIME. I'VE SEEN A LOT OF PEOPLE COME AND GO. IT'S NICE TO KNOW THAT THE WHOLE OF YOUR WORK REALLY RESTS ON PEOPLE WHO ARE BEHIND YOU. OF COURSE, SOME OF THOSE ARE STANDING NEXT TO ME, MY WIFE, CYNTHIA, MY DAUGHTER DANIELLE, AND MY SON MATTHEW. CHRISTOPHER, THE ONE THAT COULDN'T MAKE IT, HE'S IN COLLEGE. HOPEFULLY HE'LL BE OUT THIS SPRING. OF COURSE, THE OTHER PEOPLE BEHIND ME ARE THE PEOPLE SITTING OUT IN THE AUDIENCE. WE COULDN'T HAVE DONE IT, I COULDN'T HAVE HAD THE CAREER I'VE HAD WITHOUT A LOT OF THE PEOPLE THAT ARE OUT THERE WHO HELPED SUPPORT A LOT OF THE EFFORTS AND WORK THAT WE DID ALL FOR THE PURPOSE OF SERVING COMMUNITIES AND FAMILIES. THANK YOU VERY MUCH. [APPLAUSE.] 

CYNTHIA BANKS: WELL, CONGRATULATIONS, GERALDO. WHEN HE STARTED WITH OUR DEPARTMENT, HE HAD ALL BLACK HAIR. HE HAS GROWN WITH US. HE HAS BEEN ONE OF OUR EMPLOYEES THAT HAS SHOWN PASSION IN EACH AND EVERY ASSIGNMENT THAT HE HAS BEEN IN. HE HAS ENGENDERED THE SUPPORT OF THE STAFF BECAUSE HE KNOWS THAT THE COMMUNITY COMES FIRST. AND WE REALLY THANK HIM FOR THAT. AND CONGRATULATIONS ON YOUR RETIREMENT. [APPLAUSE.] 

SUP. SOLIS: I'M IN AWE BECAUSE OUR LIFE CAME BACK FULL CIRCLE. WE USED TO RENT SPACE WHEN I WAS IN THE CONGRESS FROM THE CENTRAL MARAVILLA FACILITY. SO WE BECAME GOOD FRIENDS AND WE WORKED ON A LOT OF PROJECTS THAT WE GOT FEDERALLY FUNDED FOR THE COUNTY. SO THANK YOU. AND I'M JUST DELIGHTED TO SEE YOU AND YOUR FAMILY. AND THANK YOU FOR YOUR SERVICE. [APPLAUSE.] 

SUP. ANTONOVICH, MAYOR: NOW WE'RE GOING TO RECOGNIZE THE 2-1-1 L.A. COUNTY, THE 35TH ANNIVERSARY OF THIS NUMBER. 2-1-1 L.A. COUNTY PROVIDES INFORMATION ON SERVICES FOR ELDER AND DEPENDENT ADULT ABUSE, SAFETY SURRENDER BABY, AND THE COUNTY-WIDE EMERGENCY HOTLINE. THEY PROVIDE TRANSFER SERVICES FOR THE CHILD ABUSE HOTLINE, DOMESTIC VIOLENCE SHELTERS AND THE MENTAL HEALTH ACCESS CENTERS. THE 2-1-1 L.A. COUNTY'S INFORMATION REFERRAL SERVICES ARE AVAILABLE IN MULTIPLE LANGUAGES 24/7, 24 HOURS A DAY, 7 DAYS A WEEK AT NO COST TO COUNTY RESIDENTS. 2-1-1 L.A. COUNTY IS OFTEN THE FIRST RESOURCE THAT INDIVIDUALS ACCESS WHEN THEIR FAMILIES ARE IN NEED. SO HERE TO ACCEPT THE SCROLL TODAY IS MARABEL MARVIN THE EXECUTIVE DIRECTOR AND CONGRATULATIONS. [APPLAUSE.] 

SPEAKER: THANK YOU, BOARD OF SUPERVISORS, FOR THIS RECOGNITION. 2-1-1 HAS BEEN PROVIDING SERVICES TO OUR COMMUNITY FOR A VERY LONG TIME. IT'S, YOU KNOW, QUITE A SHAME THAT MORE PEOPLE DON'T KNOW ABOUT IT. SO THIS YEAR IS REALLY GOING TO BE THE START OF A NEW CAMPAIGN TO GET THE WORD OUT. WITH ME TODAY I HAVE SOME VERY KEY PEOPLE THAT MAKE 2-1-1 WORK. I HAVE MY CHIEF OPERATING OFFICER, AMY LATSER, MY CHIEF FINANCIAL OFFICER, RUSSELL JENSEN AND I ALSO BROUGHT WITH US TODAY ONE OF THE KEY PEOPLE, ONE OF OUR COMMUNITY RESOURCE ADVISORS WHO HANDLES THE PHONE. IN FACT SHE WORKS THE GRAVEYARD. SHE'S ALSO THE LEAD STEWARD FOR THE UNION THAT REPRESENTS OUR STAFF AT SEIU 721, DENISE FRIEDMAN. I'D LIKE HER TO SAY A FEW WORDS BECAUSE SHE REALLY IS THE PERSON THAT YOU TALK TO WHEN YOU DIAL 2-1-1, SO IF YOU COULD SAY A COUPLE WORDS, DENISE, BECAUSE WE'RE REALLY PROUD OF THE WORK SHE DOES ALONG WITH ALL OF HER COWORKERS. 

DENISE FRIEDMAN: THANK YOU, I'M GLAD TO BE HERE, HONORED TO BE HERE TO REPRESENT OUR C.R.A.S AND WHAT MARIBEL SAID IT'S A SHAME THAT MORE PEOPLE DON'T KNOW ABOUT 2-1-1 AND DON'T KNOW HOW TO ACCESS THE WONDERFUL RESOURCES THAT OUR COUNTY HAS PROVIDED TO US. I'M HOPING THAT BY BEING HERE AND ACCEPTING THIS, ALONG WITH EVERYONE FROM 2-1-1, THAT WE CAN WORK TOGETHER TO SPREAD THE WORD AND GET THE HELP OUT THERE TO THOSE WHO DESERVE IT AND NEED IT. THANK YOU. [APPLAUSE.] 

SUP. ANTONOVICH, MAYOR: WE HAVE ONE-YEAR-OLD LITTLE FEMALE NAMED CUPCAKE. AND THIS IS CUPCAKE. SHE'S LOOKING FOR A HOME. YOU COULD CALL 562-728-4610 AND LITTLE CUPCAKE WILL BE YOUR LITTLE DESSERT. [LAUGHTER.] ANYWAY, CUPCAKE IS 1-YEAR-OLD. SHE'S LOOKING FOR A HOME. 

SUP SOLIS: THANK YOU. THANK YOU, MR. MAYOR, AND BOARD MEMBERS. I'D LIKE TO TAKE UP A CALL TO HAVE MR. CHESTER CHONG AND MRS. CONNIE VONG FROM THE CHINESE CHAMBER OF COMMERCE OF LOS ANGELES TO JOIN ME HERE AT THE DAIS. TODAY WE HONOR THE CHAMBER FOR THEIR 116TH ANNUAL GOLDEN DRAGON PARADE THAT CELEBRATES THE LUNAR NEW YEAR AND PROVIDES A RICH AND DIVERSE EXPERIENCE FOR PEOPLE OF ALL AGES. THE CHAMBER ACTS AS AN ADVOCATE FOR THE CHINESE BUSINESS COMMUNITY AND IT PROMOTES CULTURAL AWARENESS AND RELATIONSHIPS THROUGH EVENTS SUCH AS THE GOLDEN DRAGON PARADE AND THE MOON FESTIVAL CELEBRATIONS. THE HISTORY OF THE GOLDEN DRAGON PARADE STRETCHES AS FAR BACK AS OVER A CENTURY WHEN THE CHINESE LION AND DRAGON PROCESSION WAS PART OF THE CITY OF LOS ANGELES' ANNUAL L.A. FIESTA PARADE. IT WAS BACK IN 1956, THE CHINESE CHAMBER OF COMMERCE JOINED AND MADE SIGNIFICANT CONTRIBUTIONS TO THE PARADE, INCLUDING BRINGING IN THE SURROUNDING BUSINESS COMMUNITY TO FUND THE IMPORTING OF NEW DRAGON HEADS FROM HONG KONG AND MANY CULTURAL DANCERS. OVER 100,000 SPECTATORS LINE THE PARADE ROUTE, AND THOUSANDS MORE VIEW THE TELECAST OF THIS COLORFUL CELEBRATION THAT TAKES PLACE RIGHT HERE IN LOS ANGELES IN CHINATOWN. IT HAS BECOME THE PREMIER CULTURAL EVENT IN SOUTHERN CALIFORNIA ASIAN AMERICAN COMMUNITY. SO TODAY I'D LIKE TO RECOGNIZE THE CHINESE CHAMBER OF COMMERCE OF LOS ANGELES FOR PRESENTING THE 116TH ANNUAL LUNAR NEW YEAR'S DRAGON PARADE. AND I LOOK FORWARD TO CELEBRATING THE LUNAR NEW YEAR WHICH STARTS THIS THURSDAY, WHICH I HOPE ALL OF YOU WILL PARTICIPATE IN. AS YOU KNOW, MAY, THE YEAR OF GOAT, BRING YOU HAPPINESS AND GOOD FORTUNE. CONGRATULATIONS. [APPLAUSE.] 

SPEAKER: THANK YOU, COUNTY SUPERVISOR. AND EVERY SUPERVISOR. ON BEHALF OF LOS ANGELES CHAMBER OF COMMERCE, CHESTER AND THANK YOU. I'M SO EXCITED TODAY. REALLY HONORED TO BE HERE TODAY AND SEE EVERYONE TO GET THE HONOR, TO GET THE CERTIFICATE. BUT ONE THING I REALLY WANT TO SHARE WITH MY EXPERIENCE ON THE EIGHT YEARS ON THE CHAMBER OF COMMERCE, ONE THING IS IMPORTANT, THIS IS TEAMWORK. IT IS NOT BECAUSE I'M THE PRESIDENT OR CHAMPION TO STAND HERE, AND ON BEHALF OF CHINESE CHAMBER OF COMMERCE, THERE'S A WHOLE TEAM TO MAKE THE HARD WORK, TO BE IN THE NEW YEAR, TO MAKE THIS A SUCCESS. SO THANK YOU SO MUCH AND GIVE ME THE OPPORTUNITY TO BE HERE AND SAY HI AND ON BEHALF OF THE CHAMBER. THANK YOU AGAIN. 

SUP. KNABE: MR. MAYOR, IF I COULD, I DON'T HAVE ANY PRESENTATIONS, BUT A COUPLE OF FOLKS I WANT TO RECOGNIZE. FIRST OF ALL, WITH US TODAY, I HAD THEM UP IN THE OFFICE EARLIER, THEY'VE BEEN UP AND AROUND, WE HAVE THE LA MIRADA, CITY OF LA MIRADA, YOUTH IN GOVERNMENT GROUP. LET'S HAVE THEM STAND UP AND GIVE THEM A BIG ROUND OF APPLAUSE. [APPLAUSE.] WE'VE BEEN ANSWERING QUESTIONS AND DOING ALL KINDS OF THINGS. THE MAYOR AND THE COUNCIL DIDN'T MAKE IT, BUT THIS IS THE TEAM YOU GOT TO DEAL WITH. WHERE'S THE ANALYST? ANALYST, WAVE YOUR HAND, THERE YOU GO. HE'S GOT ALL THE MONEY. ALL RIGHT. ANYWAY, THANK YOU, GUYS, FOR BEING HERE. ALSO, ANOTHER YOUNG MAN, HE CAME UP TO THE OFFICE AND WE GOT TO SAY HELLO ALL THE WAY FROM IRELAND, MR. JAMES DONNELLY IS PART OF OUR SISTER CITIES PROGRAM. JAMES, WELCOME. [APPLAUSE.] THANK YOU, MR. MAYOR. 

SUP. ANTONOVICH, MAYOR: OKAY. LET ME CALL THE FOLLOWING. GENEVIEVE CLAVREUL, 1-D, 7, 32. ERIC PREVEN, I'M GOING TO CALL UP 5, 16 AND 27. THE OTHER TWO THAT YOU HELD, WE'LL CALL YOU WHEN THE SUPERVISORS BRING THOSE UP FOR DISCUSSION. AND MR. SACHS, 2-D, 9, 16 AND 27. AND THE SAME APPLIES TO YOU AGAIN, MR. SACHS. SO, GENEVIEVE? MR. PREVEN, MR. SACHS. 

ERIC PREVEN: [OFF MIC] DISTRICT 3 AND ALSO A CANDIDATE IN THE C.D.2 COUNCIL RACE AGAINST MR. PAUL KREKORIAN. TODAY, ITEM 32, WHICH I DON'T THINK MADE IT ON YOUR LIST, SIR, HAD TO DO WITH THE DESIGN CONTROL BOARD. I JUST WANT TO REFERENCE QUICKLY THAT WE ARE EXTENDING THAT, THE SUNSET REVIEW ON THAT GROUP, FOR -- TILL 2019 OR SOMETHING LIKE THAT. BUT THIS IS A GROUP THAT MADE A STRONG RECOMMENDATION AGAINST BOAT CENTRAL, WHICH IS AN L.L.C., BOAT CENTRAL L.L.C., WHICH WAS A FAR-FETCHED VALET BOAT SERVICE FOR OBVIOUSLY LUXURY KIND OF BOATS AND SUCH. AND THIS WAS SNUCK THROUGH DESPITE THAT OPPOSITION BY THE HARBOR DESIGN CONTROL BOARD, APPROVED BY THE BOARD OF SUPERVISORS, APPROVED BY THE COASTAL COMMISSION. I WOULD ASK THAT YOU RE-EVALUATE THAT. IT'S A TERRIBLE IDEA. AND IF THE DESIGN CONTROL BOARD MAKES RECOMMENDATIONS, WE DON'T TAKE THEM, THEN PERHAPS WE SHOULDN'T APPROVE A SUNSET REVIEW FOR SO LONG. LET'S NOT BOTHER. I THINK WE SHOULD DO IT AND FOLLOW THEIR ADVICE. THAT'S WHAT I THINK. ITEM 14 IS INTERESTING. IT'S ELECTION SYSTEM L.L.C., WHICH IS A VERY BIG NATIONAL FIRM. THEY'RE DOING A GREAT JOB LOBBYING DOWN HERE, AS YOU PROBABLY KNOW, WITH ENGLANDER, KNABE AND ALLEN. THEY TURNED UP THE HEAT OVER THE LAST COUPLE YEARS. SO WE'RE NOW LOOKING AT SIX FIGURES, I HOPE YOU'LL APPROVE ITEMS 14 AND 15 IN CONJUNCTION WITH THEIR RECOMMENDATIONS, THE LOBBYISTS RECOMMENDATIONS. ITEM 27 REALLY INFORMS THE DISCUSSION ITEMS. IT'S A SETTLEMENT IN A LAWSUIT FOR $250,000. I REMEMBER THE CASE VAGUELY. IT WAS AN OBSTRUCTION OF JUSTICE CHARGE AGAINST A WOMAN IN LANCASTER FOR A FAMILY DISPUTE. SO WE WERE SETTLING IT AT $250,000 BECAUSE SHE GOT ROUGHED UP IN THE PROCESS. I THINK IT'S WORTH LOOKING AT THE FACT THAT SHE WAS ALSO CHARGED WITH A CRIME BY THE D.A. WHEN SHE WAS -- I THINK IT'S FAIRLY CLEAR THAT THE CRIME DIDN'T STICK, SHE FILLED A CIVIL RIGHTS ACTION. WHEN WE EVALUATE THE COSTS OF THESE ISSUES, WE HAVE TO LOOK AT NOT JUST WHAT IT COSTS TO SETTLE THE LAWSUITS, BUT ALSO HOW MUCH TIME AND ENERGY WAS EXTENDED THROUGH THE D.A.'S OFFICE FIGHTING THROUGH POTENTIALLY SPECIOUS ALLEGATIONS. SO I DON'T KNOW THE DETAILS OF THAT CASE. I'M GLAD IT'S OFF OUR DESK. TODAY WE'LL HAVE A LOT MORE TO SAY ABOUT THOSE ITEMS WITH LAW AND LITIGATION AND COUNTY RISK. BUT TODAY ITEM 5 IS A LOOK AT SOMETHING COMPLETELY DIFFERENT. I'M GOING BACK TO THE AGENDIZED ITEMS. THIS IS ITEM 5, IF I'M NOT MISTAKEN. BEST PRACTICES FOR THE WAY WE CONDUCT REAL ESTATE LEASE WORK. SO THIS IS AN ERA WHERE MR. FUJIOKA WAS DRIVING THINGS. AND WE HAD A PROTOCOL THAT WE FOLLOWED. AND NOW WE ARE RE-EVALUATING, SEEING IF THERE AREN'T SOME THINGS WE COULD ADJUST. AND I FULLY SUPPORT THAT. ONE OF THE AREAS TO LOOK AT CLOSELY IS THIS IDEA OF TENANT IMPROVEMENT. BECAUSE WE HAVE LEASE RENTAL RATES THAT ARE A CERTAIN NUMBER. AND THEN THERE'S THE T.I., OR TENANT IMPROVEMENT. I THINK WE FREQUENTLY ROLLED INTO SITUATIONS THAT WORK TO THE BENEFIT OF THE LESSEES OR WHOEVER IS BASICALLY DOING THE RENTING OR THE LEASING. ANYWAY, THAT'S CONFUSING NO MATTER HOW YOU PHRASE IT BECAUSE YOU NEED TO KNOW BOTH SIDES. ANYWAY, I APPRECIATE YOU LOOKING INTO THAT AND THANK YOU. 

DR. GENEVIEVE CLAVREUL: GOOD AFTERNOON, BOARD OF SUPERVISORS, DR. GENEVIEVE CLAVREUL. WELL, I AM ONE WHO HAVE BEEN TOTALLY OPPOSED TO THE EXTENDING THE AUDIT REVIEW FOR ALL THE COMMISSIONS AND THE GROUP. MANY OF THE COMMISSION DO NOT GET AUDITED. SO SUNSET REVIEW IS PUSHED BACK. AND MANY OF THEM WON'T BE AUDITED UNTIL 2019. I HAVE BEEN MONITORING MANY OF THE COUNTY COMMISSION FOR THE LAST MANY YEARS. NOW MANY OF THE COMMISSIONS ARE SO BAD, MOST OF THEM DON'T EVEN HAVE A QUORUM. MOST OF THEM CANNOT CONDUCT BUSINESS. SO I THINK THIS IS NOT THE TIME TO EXTEND THE SUNSET REVIEW. I THINK YOU NEED TO LOOK AT IT VERY SERIOUSLY, SEE IF THE COMMISSION ARE MEETING THEIR MISSION. IS IT WORTH A WASTE OF MONEY? AND WHAT NEEDS TO BE DONE ABOUT IT? AND LIKE I SAID, IT'S NOT ONE COMMISSION IN PARTICULAR, IT'S MOST OF THEM. THE ONE I HAVE MONITORED PERSONALLY. AND MANY HAVE NOT BEEN ABLE TO APPROVE MINUTES FOR THE LAST THREE, FOUR MONTHS. SO IT'S A PRETTY SAD STORY. AND I THINK IT'S TIME TO REALLY LOOK AT EVERY TIME A REVIEW NEED TO BE DONE, YOU DO IT. DO NOT EXTEND THE REVIEW AND DO NOT EXTEND THE TERM LIMIT. AND MOST OF YOU APPOINT WITH THE CAP THAT YOU WAIVE THE TERM LIMIT. I THINK THAT'S A VERY WRONG APPROACH. AND I THINK RIGHT NOW IS NOT THE TIME TO DO IT. AND IT'S ONE AFTER THE OTHER. AND I JUST WANT TO MENTION I WOULD LIKE TO HAVE A REPLY TO MY REQUEST FOR MY RECORDS? 

SUP. ANTONOVICH, MAYOR: THE REQUEST WAS PUBLIC RECORD INFORMATION? 

DR. GENEVIEVE CLAVREUL: I HAVE NOT RECEIVED A REPLY? 

INTERIM C.E.O. SACHI HAMAI: FOR WHICH ONE? 

DR. GENEVIEVE CLAVREUL: THE ONE I PRESENTED LAST WEEK. IT WAS VERY PRECISE. HOW MS. CAROL MEYER. 

INTERIM C.E.O. SACHI HAMAI: WE'RE WORKING ON THAT REQUEST. 

DR. GENEVIEVE CLAVREUL: THAT'S VERY IMPORTANT. I'M GETTING VERY TIRED OF THOSE LITTLE SURPRISE COMING UP. SOMEBODY ALL OF A SUDDEN RE-APPEAR AND THEY ARE CONTROLLING THE MERGER WHO HAS ALREADY BROUGHT DOWN OUR THROAT UNDER AN ITEM WAS BROUGHT FROM A CLOSED SESSION. AND I WILL BEG TO DIFFER WITH THE COUNTY COUNSEL, THAT WAS A STRAIGHT VIOLATION OF THE BROWN ACT. YOU HAD NO RIGHT TO DO THE WAY YOU DID IT. THANK YOU. 

SUP. ANTONOVICH, MAYOR: THANK YOU. MR. SACHS? 

ARNOLD SACHS: YES, THANK YOU. GOOD AFTERNOON, ARNOLD SACHS. AND I DID HOLD SEVERAL ITEMS. I ACTUALLY HELD 1-D, AND YOU LOOK AT THE MATH, IT'S ACTUALLY $50,000 FOR ADMINISTRATIVE COSTS FOR THE COMMUNITY DEVELOPMENT COMMISSION ON A $500,000 FUNDING FOR THE HOMELESS SERVICE CENTER FUND. SO THE HOMELESS SERVICE CENTER FUNDS, HOW MUCH IS IN THAT POT, BASICALLY, TO BE USED FOR 10 PERCENT FOR COMMISSION FOR ADMINISTRATIVE COSTS? IS IT $10 MILLION? $20 MILLION? 10 PERCENT OF THAT? WHAT IS THE ACTUAL AMOUNT THAT THEY GET TO SPEND AND YOU GET TO LIKE CARVE OUT 10 PERCENT ADMINISTRATIVE COSTS EVERY TIME YOU PUT AN ITEM ON YOUR AGENDA FOR THEM. BECAUSE THAT'S AN AWFUL LOT OF MONEY FOR ADMINISTRATIVE. IT'S NOT QUITE AS MUCH AS THE STATE WAS GETTING. THAT ONE ITEM WAS 20 PERCENT. THAT'S REALLY STEALING. I HELD ITEM 2-D. IT'S AN AGREEMENT TO NEGOTIATE EXCLUSIVELY FOR SOME PROPERTY. AND I'M THINKING ABOUT AN AGREEMENT TO NEGOTIATE EXCLUSIVELY. DIDN'T SUPERVISOR RIDLEY-THOMAS HAVE SOME QUESTIONS ABOUT 1776, THE AGREEMENT WITH THE COUNTY AND 1776 SATURN L.L.C. ABOUT AGREEMENT TO NEGOTIATE EXCLUSIVELY? HOW WAS THAT EVER RESOLVED? I DON'T BELIEVE IT WAS EVER RESOLVED. I DON'T THINK IT EVER CAME BACK TO THE COUNTY BOARD. SO NOW YOU HAVE ANOTHER AGREEMENT TO NEGOTIATE EXCLUSIVELY. WELL, YOU KNOW, THAT'S JUST HOW THE BOARD ROLLS. I HELD ITEM 9, IT'S A VOLTAGE SYSTEM FOR $2.8 MILLION. AND THE FINANCING AT 665,000 FOR FIVE YEARS COMES TO A TOTAL REPAYMENT OF 3.2 MILLION OR $425,000 IN INTEREST, WHICH IS LIKE ALMOST 14 PERCENT. IS THAT THE BEST THE COUNTY CAN DO? I HELD ITEM 16. IT MENTIONS SOMETHING ABOUT THE REGIONAL PARK AND OPEN SPACE DISTRICT'S PROCEDURAL GUIDELINES. WELL WHO KNEW? I MEAN, REMEMBER LAST YEAR, WAS IT LAST YEAR OR THE YEAR BEFORE WHEN YOU HAD THE WHITTIER FIASCO ABOUT HOW THEY USED OPEN PARK SPACE, OPEN LAND TO LEASE OUT FOR OIL WELLS? BUT IF YOU HAVE GUIDELINES AND THE GUY FROM THE OIL COMPANY SAID THAT COUNTY COUNSEL KNEW ABOUT THE LEASE AGREEMENT, IF YOU HAVE GUIDELINES, HOW COULD THEY GET THE LEASES APPROVED? OR MAYBE IT WAS LIKE A MORATORIUM ON THE GUIDELINES. WE DON'T KNOW. MAYBE IF RICK ORLOV WAS AROUND, HE COULD ASK THOSE QUESTIONS. UNFORTUNATELY HE PASSED AWAY. THAT'S TOO BAD BECAUSE WE KNOW HOW WELL HE COVERED THE COUNTY GOVERNMENT. SO AGAIN YOU HAVE GUIDELINES HERE BUT YOU DON'T HAVE GUIDELINES THERE. SO WHICH IS IT? AND THEN 27 EXCESSIVE FORCE FROM THE SHERIFF'S FIELD DEPUTIES? WE HEAR SO MUCH ABOUT THE JAILS. WHEN ARE THE CAMERAS COMING BACK ON? WHEN WILL THEY BE BACK ON THE AGENDA? 

SUP. ANTONOVICH, MAYOR: THANK YOU. LORAYNE LINGAT, DPTY, EXEC. OFCR: MR. MAYOR, WE HAVE ITEMS 1-D, 2-D, 5, 7, 9, 16, 27 AND 32 BEFORE YOU. 

SUP. ANTONOVICH, MAYOR: OKAY. MOTION BY SUPERVISOR KUEHL. SECOND WITHOUT OBJECTION, SO ORDERED. WE HAVE THE DEPUTY DIRECTOR FOR THE REGISTRAR-RECORDER? ITEM 14. THIS WAS THE ISSUE THAT WAS BEFORE THE BOARD, WHICH WAS WITH THE RENEWAL WITH OPTIONS BEING EXTENDED, $10 MILLION CONTRACT FOR FIVE YEARS. AND WE WERE TOLD THAT THERE WERE 140 VENDORS THAT WERE NOTIFIED ABOUT THE I.F.B. AND MY OFFICE DID AN INVESTIGATION, AND THEY FOUND 140 VENDORS SUPPOSEDLY HAVE BEEN CONTACTED FOR THIS I.F.B. TO BID ON THIS PROJECT AND ONLY TWO VIABLE BIDS CAME IN. IN CHECKING THIS MORNING AND THIS PAST WEEK, PITNEY-BOWES, THE DIRECTOR OF GOVERNMENT SALES, DID NOT RECEIVE THE I.F.B. AND WOULD HAVE BEEN INTERESTED IN RESPONDING. XEROX REPRESENTATIVE NEVER RECEIVED AND WOULD ALSO HAVE BEEN INTERESTED IN RESPONDING. ALPHA PRINTING NEVER RECEIVED AND WOULD BE INTERESTED IN BIDDING. KATIE LEE FROM STANDARD REGISTER COMPANY NEVER RECEIVED A BID. PASSWORD FOR THE COUNTY VENDOR RELATIONS WEBSITE HAS EXPIRED. SHE COULD NOT EVEN LOG IN TO THE COUNTY VENDOR RELATIONS MAIL TO SEE IF A BID HAD BEEN POSTED BECAUSE THE MAILBOX WAS FULL. TRIED TO CALL LISTED PHONE NUMBER MULTIPLE TIMES, WHICH WENT RIGHT TO VOICE MAIL EACH TIME. SO NEVER RECEIVED BID ON HER COMPANY'S EMAIL DESPITE REGISTER RECORDER'S LISTING HER EMAIL AND OTHERS IN ITS FEBRUARY 10TH REPORT. THE CONCLUSION IS THAT THE SYSTEM IS FLAWED AND WE DID NOT HAVE A FAIR PARTICIPATION OF THE PRIVATE SECTOR'S ABILITY TO BID ON THIS MULTI-MILLION DOLLAR CONTRACT. THE QUESTION IS: THE PROCESS OF GOING OUT AND DOING ANOTHER BID BUT INSURING THAT EVERYBODY RECEIVES THE INFORMATION. AND IS THE DEPARTMENT ABLE TO DO THAT? AND WHAT WOULD WE HAVE TO DO TO ALLOW YOU TO DO THAT? 

SPEAKER: CURRENTLY THE CONTRACT EXPIRES FEBRUARY 28TH OF THIS MONTH. SO WE WOULD NEED TO EXTEND THE CURRENT CONTRACT AND RE-BID. 

SUP. ANTONOVICH, MAYOR: AND THAT'S POSSIBLE? 

SPEAKER: YES, IT'S POSSIBLE. 

INTERIM C.E.O. SACHI HAMAI: MR. MAYOR, IF I MAY, IF THAT'S THE DIRECTION THAT THIS BOARD WOULD LIKE TO GO, YOU MAY WANT TO AMEND THE MOTION TO GO ON A MONTH-TO-MONTH FOR SIX MONTHS IN ORDER FOR THE REGISTRAR-RECORDER TO RE-BID THE PROCESS. 

SUP. ANTONOVICH, MAYOR: AND ALSO, REVIEWING THE BIDDING PROCESS, WOULD THIS BE SOMETHING THAT THE PRODUCTIVITY COMMISSION SHOULD REVIEW? IS IT SOMETHING THAT THE AUDITOR-CONTROLLER SHOULD REVIEW? OR IS IT SOMETHING YOUR DEPARTMENT SHOULD REVIEW? OR IS IT COMBINATION OF THE THREE? OR WHAT WOULD YOU RECOMMEND? 

INTERIM C.E.O. SACHI HAMAI: I THINK WE COULD TAKE A LOOK AT IT -- 

SUP. ANTONOVICH, MAYOR: RECOMMENDATIONS BACK? 

INTERIM C.E.O. SACHI HAMAI: WITH THE INTERNAL SERVICES DEPARTMENT AND THEN REPORT BACK TO YOU ON IT. 

SUP. ANTONOVICH, MAYOR: OKAY. QUESTIONS? SUPERVISOR KUEHL? SUPERVISOR KNABE? 

SUP. KUEHL: THANK YOU, MR. MAYOR. MY QUESTION WOULD BE WHETHER SUCH A DELAY WOULD HAVE AN IMPACT ON ANY UPCOMING ELECTION. 

SPEAKER: NO, IT WOULD NOT. AS LONG AS WE CAN EXTEND THE CONTRACT, WE CAN CONTINUE TO DO AND SEND OUT THE OUTGOING PACKETS FOR VOTE BY MAIL. 

SUP. KNABE: MY QUESTION IS: DO WE HAVE ACCESS TO THE INFORMATION YOU HAVE? 

SUP. ANTONOVICH, MAYOR: MY OFFICE MADE THE CALLS TO THESE DEPARTMENTS, OR THESE BUSINESSES. AND I WOULD ASSUME THAT -- AND THE REGISTRAR GAVE US A REPORT BACK ON FRIDAY. 

SUP. KNABE: I HAVEN'T SEEN. THE PAST FRIDAY? 

SUPERVISOR SOLIS: I GUESS AS LONG AS WE CAN CONTINUE ON A MONTH-TO-MONTH BASIS, I DON'T HAVE A PROBLEM WITH TAKING ANOTHER LOOK AT THE BID PROCESS AND HAVING OUR STAFF -- BECAUSE THIS IS A PROBLEM THAT I THINK -- NOT A PROBLEM, BUT A CONCERN THAT I'VE HAD FOR OTHER GRANTS THAT HAVE GONE OUT OR CONTRACTS, PUT IT THAT WAY. BUT THE ISSUE THAT THE MAYOR BROUGHT UP REGARDING ACCESS FROM THE PUBLIC TO BE ABLE TO GET ONLINE, THAT'S A BIT TROUBLESOME. SO CAN YOU LOOK INTO THAT AND REPORT BACK TO US? 

INTERIM C.E.O. SACHI HAMAI: WE'LL INCLUDE THAT IN THE REPORT, AS WELL. 

SUP. ANTONOVICH, MAYOR: WE HAVE TWO PUBLIC SPEAKERS ON THE ITEM. THANK YOU. 

SUP. SOLIS: THANK YOU. 

SUP. ANTONOVICH, MAYOR: MR. PREVEN AND MR. SACHS. ONE MINUTE EACH. 

ERIC PREVEN: 60 SECONDS? THANK YOU, I'LL DO MY BEST SIR. IT'S ERIC PREVEN, THE COUNTY RESIDENT FROM DISTRICT 3. I LIGHTLY REFERENCED THIS IN MY EARLIER REMARKS. THIS IS A GROUP THAT IS LOBBYING THROUGH ENGLANDER, KNABE AND ALLEN. JUST LIKE ENTERPRISE. IF YOU REMEMBER A FEW YEARS AGO WE HAD THE SAME PROBLEM. THERE WAS AN R.F.P. THAT WAS SUPPOSED TO GO OUT FOR RENTAL CAR AGREEMENTS FOR THE COMMUNITY DEVELOPMENT COMMISSION AND NOBODY RECEIVED THE PACKET. SAME SORT OF THING. NOW, I CAN'T MAKE ALLEGATIONS BECAUSE I DON'T SIT ON THAT SIDE OF THE DESK. BUT YOU ALL HAVE A LOT OF INTERACTION WITH THESE GROUPS, AND THEY INTERACT AGGRESSIVELY LIKE FOR EXAMPLE MS. HAMAI, SHE IS NOW THE C.E.O. BUT SHE WAS THE EXECUTIVE OFFICER WHO OVERSAW ALL THE LOBBYING. SO YOU GOT TO CLEAN UP THE BACK DOOR LOBBYING PIECE AND THEN I THINK FAIR AND OPEN BIDS IS WHAT OF COURSE WE ALL EXPECT. THERE'S OTHER EXAMPLES. GOLF, TODAY WE DID HONOR MR. FENNESSY WHO OBVIOUSLY INDIVIDUALLY IS A GREAT MAN FROM PASADENA BUT HAS PARTICIPATED IN R.F.P.S WHERE AMERICAN GOLF WINS AND PULL IT OUT OF THE HAT AND THERE'S SOME STRANGE ASPECT TO HOW THINGS GET DONE DOWN HERE THAT WE HAVE TO GET CONTROL OF. SO I THANK YOU FOR BEING A LEADER ON THAT, SIR. 

SUP. ANTONOVICH, MAYOR: MR. SACHS? 

ARNOLD SACHS: WHY, YES, THANK YOU. THE WAY I LOOKED AT THIS IS IT'S FUNDING FOR VOTE BY MAIL. AND I'M JUST CURIOUS TO KNOW WHEN THE BOARD IS GOING TO TACKLE THE FUNDING FOR THE STIPEND FOR THE ELECTION WORKERS THEMSELVES, THE POLL WORKERS. YOU KNOW, START AT 6:00 IN THE MORNING ON ELECTION DAY AND YOU WORK UNTIL 8:30 AND THAT DOESN'T INCLUDE THE TWO HOURS OF CLASS THAT YOU'RE REQUIRED TO TAKE, WHICH IS $25? AND YET THE COUNTY AND THE STATE AND EVERYBODY, THE CITY OF L.A., THEY'RE ALL TALKING ABOUT RAISING THE MINIMUM WAGE? YOU'RE BARELY MAKING MINIMUM WAGE AS AN ELECTION WORKER RIGHT NOW, VOLUNTEER, I GUESS, THAT SAVES EVERYBODY A PROBLEM. BUT DON'T YOU THINK YOU SHOULD LOOK INTO THAT, TOO? I UNDERSTAND THAT IF YOU WORK FOR THE GOVERNMENT AND YOU WORK AS A POLL WORKER, YOU GET YOUR SALARY, I THINK, AM I CORRECT THAT YOU GET YOUR SALARY THAT YOU'D GET PAID FOR IF YOU WORKED AT YOUR GOVERNMENT JOB? WHICH IS FINE. GETS YOU OUT OF THE OFFICE, BASICALLY. BUT AS A POLL WORKER? $7.25 AN HOUR? THAT AIN'T THAT GREAT. THAT ACTUALLY IS NOT THAT GREAT AT ALL. IT'S A LOT OF FUN BUT IT AIN'T THAT GREAT. 

SUP. ANTONOVICH, MAYOR: THANK YOU. I'LL MOVE AND SECONDED BY SUPERVISOR SOLIS. ANY OBJECTION, SO ORDERED. AS AMENDED. 

SUP. KNABE: WHAT'S THE AMENDMENT? 

SUP. ANTONOVICH, MAYOR: WITH THE AMENDMENT AS STATED. 

SUP. KNABE: IT WON'T IMPACT THE CURRENT ELECTION, RIGHT? 

SUP. ANTONOVICH, MAYOR: NO. 

SPEAKER: RIGHT. 

SUP. ANTONOVICH, MAYOR: RIGHT. OKAY. LET ME -- THIS WAS A SAD WEEK BECAUSE MANY OF US LOST SOME VERY GOOD FRIENDS AND ASSOCIATES. ONE, THIS IS A MOTION COAUTHORED BY SUPERVISOR HILDA SOLIS ON THE PASSING OF STAN CHAMBERS. 

SUP. KNABE: ALL MEMBERS. 

SUP. ANTONOVICH, MAYOR: ALL MEMBERS WILL GO ON THAT. STAN WAS A PERSON I GREW UP WITH, AS ALL OF US DID WITH, MY CHILDREN WERE GROWING UP WITH BECAUSE HE CONTINUED TO BE ACTIVE IN THE COMMUNITY AS A MASTER OF CEREMONIES I KNOW AT THE FOREST LAWN VETERANS' CEREMONY WE DO EACH VETERANS' DAY, HE HAD BEEN THE MASTER OF CEREMONIES YEAR AFTER YEAR AFTER YEAR. AND THE AUTRY MUSEUM, JUST GOING RIGHT DOWN THE LIST. BUT HE WAS REALLY A WONDERFUL PERSON. HE HAD INTEGRITY. HE DIDN'T HAVE TO ELABORATE ON FALSE ASSERTIONS AND REPORTING THE NEWS, HE WAS ACTUALLY THERE AND YOU SAW WHAT HE HAD SEEN AND HE REPORTED IT SO ADROITLY. AND I REMEMBER GROWING UP WITH TELEVISION FIRST INVENTED, BASICALLY, FOR THE MASS POPULATION. HE WOULD BE STANDING ON HOLLYWOOD AND VINE WITH HIS MICROPHONE IN FRONT OF THE DEPARTMENT STORE INTERVIEWING PEOPLE ON THE STREET. THAT'S HOW HE STARTED. AND THEN ON THE CECIL BEANIE ON CHANNEL 5, HE WOULD BE THE NEWSCASTER ON SOME OF THE CECIL AND BEANIE'S EPISODES AND GOING ON AND ON. AND HE WAS A DEVOTED CHRISTIAN. HE WENT TO MASS EVERY WEEK AT HIS CHURCH IN BEVERLY HILLS. AND HIS CHILDREN AND HIS GRANDCHILDREN AND HAVING HIS GRANDSON FOLLOW IN HIS FOOTSTEPS WHO WAS -- JAMIE WAS AT CHANNEL 5, NOW HE'S IN SAN DIEGO REPORTING. BUT HE WAS SUCH A GREAT ROLE MODEL AND A WONDERFUL MAN. HE WAS A GRADUATE OF U.S.C., WHERE HE WAS PART OF THE NAVY'S OFFICER TRAINING PROGRAM. AND HE JOINED K.T.L.A. AS A PRODUCTION ASSISTANT IN DECEMBER OF 1947 AND WORKED THERE FOR MORE THAN 60 YEARS. AND LIKE TWO OF HIS COLLEAGUES THAT HE HAD GREAT ADMIRATION FOR, LARRY MCCORMICK AND HAL FISHMAN, THEY HAVE BUILDINGS NAMED AFTER THEM IN THAT WONDERFUL STATION. HE WAS AN ICON IN BROADCASTING WHO BROUGHT THE LATEST BREAKING NEWS STORIES INTO OUR HOME ALONG WITH THOROUGH COVERAGE AND THOUGHTFUL ANALYSIS. AS I SAID, HE WAS A MAN OF INTEGRITY. HE WAS OBJECTIVE, HONEST AND FAIR, QUALITIES WHICH EARNED HIM GREAT RESPECT AND ADMIRATION FROM THE HIGHEST PRAISE. AS I SAID, HE IS SURVIVED BY HIS WIFE GEGE, HIS SECOND WIFE. HIS FIRST WIFE PASSED ON. AND SHE WAS A GREAT SUPPORTER AND HELPER. AND HIS 11 CHILDREN AND GRANDCHILDREN. HE HAD 11 CHILDREN. HE DID ALL OF THIS AND YOU WOULD NEVER HAVE THOUGHT HE HAD A STRESSFUL DAY IN HIS LIFE BECAUSE HE WAS ALWAYS SO COOL AND CALM. MAYBE OTHERS WANT TO COMMENT ON STAN'S PASSING. 

SUP. SOLIS: I JUST WANT TO SAY THAT GROWING UP, WE WOULD CONSTANTLY WATCH HIM ON THE NEWS. AND HE JUST HAD THIS PARTICULAR WAY OF CONVEYING IN A VERY SIMPLISTIC MANNER WHAT WAS GOING ON. CURRENT EVENTS, WHETHER THEY WERE VERY BAD OR VERY GOOD. HE JUST HAD THAT DEMEANOR ABOUT HIM. BUT I REMEMBER HIM INTERVIEWING ME QUITE A FEW TIMES WHEN I WAS OUT HERE AND HE WAS JUST A LOVELY MAN. SO I WISH HIS FAMILY OUR BEST WISHES AND PRAYERS. 

SUP. ANTONOVICH, MAYOR: SHEILA? 

SUP. KUEHL: I WAS REALLY STRUCK WATCHING THE TRIBUTES FROM TELEVISION TO HIM FROM OTHER NEWSCASTERS ON OTHER STATIONS ON OTHER CHANNELS. EVERYONE HAS A FEELING THESE DAYS THAT JOURNALISM IS REALLY CHANGING AND THAT EVERY TIME YOU LOSE ONE OF THESE SORT OF MAJOR OLD TIME JOURNALISTS, THAT REALLY SOMETHING IS LOST IN TERMS OF THE PROFESSION ITSELF. I'M NOT SO SURE THAT'S THE CASE BECAUSE THE OTHER THING THAT STRUCK ME IS THIS COMMON CULTURE THAT WE HAVE. 7 MILLION OF US ALL WATCHING THE SAME PERSON AT THE SAME TIME AND FEEL LIKE THEY'RE REALLY A PART OF KIND OF A TRUSTED NETWORK. SO HOPEFULLY THE LESSONS THAT HE HAD TO TEACH WON'T BE LOST ON ANY GENERATION. BUT HE WILL CERTAINLY BE MISSED. 

SUP. KNABE: NOT A LOT YOU CAN ADD TO THAT. I THINK THE POINT IS AS THEY HAVE GONE ON AND MOVED ON AND THEY HAVE LEFT THIS WORLD, THAT THEIR IMPACT ON THE JOURNALISM SOCIETY HERE IN SOUTHERN CALIFORNIA IS GREATLY IMPACTED. I THINK MIKE SAID IT THE BEST. HE WAS ALWAYS COOL AND CALM AND COLLECTED, EVEN IN SOME VERY STRENUOUS SITUATIONS. THE POINT BEING HE WAS ALWAYS FAIR. AND HE NEVER HAD TO DOUBLE BACK ON HIS STORIES. HE WAS NOT A CONNECT-THE-DOT JOURNALIST. HE WAS A JOURNALIST. AND I THINK THAT'S A SUPREME COMPLIMENT. I AGREE WITH YOU, SHEILA. WHEN YOU LOOKED AT ALL THE COMMENTS THAT CAME IN FROM COMPETITORS, IT WAS PRETTY AMAZING, THE THOUGHTS THAT THEY HAD FOR A VERY FINE GENTLEMAN AND A GREAT AMERICAN. 

SUP. ANTONOVICH, MAYOR: I WOULD ALSO LIKE TO MOVE WE ADJOURN IN MEMORY OF JUDGE JAMES DI GIUSEPPE WHO WAS A RETIRED MEMBER OF OUR COURT. PASSED AWAY AT THE AGE OF 86. HE WAS ALSO A PERSONAL FRIEND, SUPPORTERS AND ONE OF MY COMMISSIONERS. HE HAD SERVED ON LAFCO FOR A NUMBER OF YEARS. HE JOINED THE NAVY AFTER GRADUATING FROM HIGH SCHOOL. SERVED IN SHANGHAI CHINA WITH THE UNITED STATES NAVY. IN 1966, HE HAD SERVED, BEEN APPOINTED TO THE BENCH WHERE HE HAD SERVED FOR 10 YEARS. HE ALSO LATER BECAME CHAIRMAN OF THE BOARD OF DIRECTORS OF FIRST CITIZENS BANK, PRESIDENT OF AGRISWISS CORPORATION AND QUITE INVOLVED WITH THE COMMUNITY. HE IS SURVIVED BY HIS WIFE EVA AND DAUGHTER, BROTHER AND TWO GRANDCHILDREN. HE WAS A VERY GOOD MAN. ANOTHER MAN WHO USED TO BE A LEADER IN LOS ANGELES COUNTY AND AS PRESIDENT OF THE BANK OF AMERICA AND THEN WHEN THE BANK WAS SOLD HAD TO LEAVE OUR GREAT STATE, A WONDERFUL MAN, LIAM MCGEE DIED. AND HE WAS THE FORMER CHAIRMAN, C.E.O. AND PRESIDENT OF HARTFORD. HE PASSED AWAY AT THE AGE OF 60. HE HAD SERVED AS THE PRESIDENT OF THE CONSUMER AND SMALL BUSINESS BANK FOR BANK OF AMERICA. HE OVERSAW MORE THAN 5,000 BRANCHES. HE LED THE FINANCIAL TURN-AROUND OF THE HARTFORD INSURANCE COMPANY AND WAS RECOGNIZED FOR HIS CONTRIBUTIONS AS A BUSINESS AND COMMUNITY LEADER. IN LOS ANGELES COUNTY HE SERVED ON NUMEROUS BOARDS, INCLUDING CHAIRMAN OF THE UNITED WAY OF GREATER LOS ANGELES, THE JUNIOR ACHIEVEMENT OF SOUTHERN CALIFORNIA WHERE HE WAS A GRADUATE OF. HE SERVED ON THE UNIVERSITY OF SAN DIEGO BOARD OF TRUSTEES AND HE IS SURVIVED BY HIS WIFE AND FOUR CHILDREN. VERY GOOD PERSON, ROLE MODEL AND QUITE INVOLVED IN MANY OF OUR ACTIVITIES IN THE COUNTY OF LOS ANGELES BEFORE THE BANK OF AMERICA WAS SOLD. RONALD MENARD PASSED AWAY AT THE AGE OF 72. HE HAD SERVED ON THE TAX BOARD FOR LOS ANGELES COUNTY FOR MANY YEARS. AND HE IS SURVIVED BY HIS TWO DAUGHTERS AND THREE BROTHERS. ANOTHER LONG-TIME RADIO TELEVISION LEGEND, GARY OWENS, PASSED AWAY AT THE AGE OF 80, HOSTING -- ALL MEMBERS -- HOSTING THOUSANDS OF RADIO PROGRAMS, APPEARED IN DOZENS OF FILMS AND TELEVISION SHOWS, ALSO WAS AN EMCEE AT MANY OF THE VARIOUS COMMUNITY EVENTS. HE WAS WELL KNOWN FOR HIS ROLE IN THE DICK MARTIN TELEVISION SKETCH "LAUGH-IN." AND HE WAS FREQUENTLY HEARD ON A WIDE VARIETY OF LOS ANGELES COUNTY RADIO STATIONS INCLUDING K.M.P.C., K.F.I AND KISS-F.M. HE HOSTED THE NATIONAL SHOW ON THE MUSIC OF YOUR LIFE NETWORK AND PART OF ARMED FORCES RADIO FOR 10 YEARS AND HOST OF THE SYNDICATED SOUND TRACK OF THE '60S. HE WAS INDUCTED INTO THE NATIONAL RADIO HALL OF FAME IN 1995 AND THE NATIONAL TELEVISION HALL OF FAME IN 2001. AND HE IS SURVIVED BY HIS WIFE AND TWO SONS. LONGTIME RESIDENT OF LOS ANGELES COUNTY WAS LEE ANN READ, PASSED AWAY AT THE AGE OF 76. SHE HAD BEEN A REGISTERED NURSE FOR THE COUNTY OF LOS ANGELES UNTIL HER RETIREMENT BACK IN 1991. SHE IS SURVIVED BY HER THREE CHILDREN. RICHARD TOM PASSED AWAY AT THE AGE OF 87. HE HAD SERVED IN THE UNITED STATES NAVY ON THE U.S.S. WEST VIRGINIA AND WAS AN ARCHITECT AFTER HE WAS DISCHARGED FROM THE NAVY. HE WAS PRESIDENT OF THE ORANGE COUNTY CHAPTER OF THE AMERICAN INSTITUTE OF ARCHITECTS AND THE CHINESE-AMERICAN ARCHITECTS ASSOCIATION. HE HAD SERVED AS A PLANNING COMMISSIONER FOR THE CITY OF HUNTINGTON BEACH AND DESIGNED THE FLAGSHIP BANK OF AMERICA IN LOS ANGELES CHINATOWN. HE'S SURVIVED BY HIS WIFE AND HIS TWO DAUGHTERS AND GRANDCHILDREN. JANIS CROWHURST, LONGTIME RESIDENT OF PASADENA, HAD BEEN VICE PRESIDENT ON THE BOARD OF DIRECTORS OF W.C. HENDRIE COMPANY AND ACTIVE MEMBER OF THE FIRST CHURCH OF CHRIST. ALSO INVOLVED WITH THE EAST PASADENA REPUBLICAN WOMEN'S FEDERATION AND THE ASSISTANCE LEAGUE OF LOS ANGELES COUNTY. AND SHE'S SURVIVED BY HER HUSBAND AND THREE CHILDREN. WALTER WILKISON, RETIRED DEPUTY, LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. ROSE TOREN, A POLISH HOLOCAUST SURVIVOR AND MOTHER OF BEVERLY HILLS MAYOR, AND I'LL HAVE SUPERVISOR KUEHL JOIN ME, OR I'LL JOIN YOU, WHO PASSED AWAY ON FEBRUARY 5TH. AND SHE HAD BEEN PLACED IN A CONCENTRATION CAMP, AS I SAID, DURING WORLD WAR II AND ESCAPED AFTER ONLY A FEW DAYS BEFORE IT WAS LIBERATED BY THE RUSSIAN FORCES. AND AFTER THE WAR, SHE HAD IMMIGRATED TO THE UNITED STATES AND SHE WROTE A BOOK CALLED "DESTINY" CHRONICLING HER EXPERIENCES DURING AND AFTER THE HOLOCAUST AND SHE IS SURVIVED BY HER DAUGHTER MARY. EARNEST RAMIREZ, RETIRED DEPUTY, LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. BERT PUCCI, PASSED AWAY AT THE AGE OF 91. ALSO WORLD WAR II VETERAN. AND HE WAS IN THE SOUTH PACIFIC DURING THAT WAR. HE BEGAN A SUCCESSFUL CAREER IN PUBLISHING AFTER HE WAS DISCHARGED AND JOINED "LOS ANGELES MAGAZINE" IN 1961 AND RETIRED ON HIS 25TH ANNIVERSARY AS THE PUBLISHER. HE IS SURVIVED BY HIS WIFE AND FOUR CHILDREN. CHARLES MCCARTHY PASSED AWAY AT THE AGE OF 92. ALSO WORLD WAR II NAVAL AVIATOR. SET UP A SUCCESSFUL LAW PRACTICE IN LOS ANGELES COUNTY AND SERVED AS THE PRESIDENT OF THE BEVERLY HILLS, BAR JUNIOR BAR ASSOCIATION AND THE WESTWOOD HILLS BAR ASSOCIATION. KAMMA ELIZABETH KISSACK, 30-YEAR RESIDENT OF QUARTZ HILL PASSED AWAY AT THE AGE OF 69. SHE WAS SUCCESSFUL IN THE HOT AIR BALLOON BUSINESS WITH HER HUSBAND AND WHO HAD ALSO SERVED AS A BOARD MEMBER OF THE QUARTZ HILL CHAMBER OF COMMERCE. RUDY EUDORO GRIMALDO, LONGTIME RESIDENT OF SANTA CLARITA, SERVED IN THE UNITED STATES ARMY DURING OPERATION DESERT STORM AND LATER WORKED FOR GENERAL MOTORS. PASSED AWAY AT THE AGE OF 72. ARTHUR GLASIER, RETIRED LIEUTENANT FROM LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. "FITZ" FULTON, LONGTIME RESIDENT OF THE ANTELOPE VALLEY, PASSED AWAY AT THE AGE OF 89. HE HAD RETIRED AS NASA DRYDEN'S CHIEF PILOT AFTER 35 YEARS OF SERVICE AS BOTH AN AIR FORCE AND CIVILIAN TEST PILOT. HIS MILITARY CAREER BEGAN -- INCLUDED 55 COMBAT MISSIONS IN KOREA AND 225 MISSIONS DURING THE BERLIN AIRLIFT. EDWARD LEROY CONLY, LONGTIME RESIDENT OF GLENDORA, SERVED AS THE ATHLETIC DIRECTOR OF CITRUS COMMUNITY COLLEGE FOR NEARLY 40 YEARS. HE'S SURVIVED BY HIS WIFE AND CHILDREN. JOHNNY BRIGHT, RETIRED DEPUTY SHERIFF, LONGTIME FAMOUS COACH, JERRY TARKANIAN PASSED AWAY AT THE AGE OF 84. HE HAD BEEN FORMERLY A COACH AT LONG BEACH CALIFORNIA STATE UNIVERSITY LONG BEACH. HE BEGAN HIS CAREER THERE LEAVING IN '73 FOR THE UNIVERSITY OF NEVADA. HE WAS SIGNED AS THE HEAD COACH OF THE SAN ANTONIO SPURS IN '92 AND ENDED HIS COACHING AT HIS ALMA MATER, CALIFORNIA STATE UNIVERSITY FRESNO. HE WAS INDUCTED INTO THE BASKETBALL HALL OF FAME IN 2013. REPUBLICAN NOMINEE FOR THE SECRETARY OF STATE IN '26 FOR THE STATE OF NEVADA AND CANDIDATE FOR THE UNITED STATES SENATE. HE IS SURVIVED BY HIS WIFE AND FOUR CHILDREN. HE PASSED AWAY AT THE AGE OF 84. AND DEPUTY DIANA BEELER, LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. DR. FORREST "FROSTY" BOYD, LONG- TIME RESIDENT OF LA CANADA, PASSED AWAY AT THE AGE OF 94. RETIRED O.B.G.Y.N., PHYSICIAN, ACTIVE MEMBER OF THE KIWANIS CLUB, SERVING AS PRESIDENT FROM 1997 TO '98. SURVIVED BY FOUR CHILDREN, EIGHT GRANDCHILDREN AND EIGHT GREAT GRANDCHILDREN. AND SERGEANT RAY CLUFF, LOS ANGELES COUNTY SHERIFF'S DEPARTMENT AND ALSO VETERAN OF THE UNITED STATES AIR FORCE. SECONDED BY SUPERVISOR KNABE. WITHOUT OBJECTION, SO ORDERED. SUPERVISOR SOLIS? 

SUP. SOLIS: THANK YOU. I MOVE THAT WHEN WE ADJOURN TODAY, WE ADJOURN IN THE MEMORY OF CARLOS COVARUBBIAS, CARLOS WAS A YOUNG MAN WHO TRAGICALLY LOST HIS LIFE. HIS BODY WAS FOUND SOUTH OF WHITTIER NARROWS RECREATION AREA ON FEBRUARY 11TH. HE WAS JUST 17. A RESIDENT OF PICO RIVERA, CARLOS WAS ALLEGEDLY A VICTIM OF A HIT-AND-RUN ACCIDENT. THAT INVESTIGATION IS ONGOING. HE WAS BORN IN INGLEWOOD. AND AT THE AGE OF 17 HE PASSED. HE ATTENDED EL RANCHO HIGH SCHOOL AND RUBEN SALAZAR HIGH SCHOOL. HE WANTED NOTHING MORE THAN TO BECOME -- TO CONTRIBUTE TO HIS COMMUNITY AND BECOME WELL VERSED IN THE AUTOMOBILE INDUSTRY. HE IS GRATEFUL FOR HIS FAMILY'S SACRIFICES AND HE'LL BE REMEMBERED FOR HIS GREAT LOVE OF HIS MOTHER AND FATHER. HE'S SURVIVED BY HIS MOTHER, MATILDA, FATHER FERNANDO AND HIS SISTER AND HOST OF EXTENDED FAMILY MEMBERS AND FRIENDS WHO WILL MISS HIM DEARLY. 

SUP. ANTONOVICH, MAYOR: SECOND, WITHOUT OBJECTION, SO ORDERED. SUPERVISOR KUEHL? 

SUP. KUEHL: THANK YOU, MR. MAYOR. I MOVE THAT WHEN WE ADJOURN TODAY, WE ADJOURN IN MEMORY OF LAWRENCE SILVERTON, LONGTIME RESIDENT OF THE THIRD DISTRICT IN ENCINO, AN ATTORNEY AND REAL ESTATE DEVELOPER WHO RECENTLY PASSED AWAY AT THE AGE OF 89 IN HIS ENCINO HOME AFTER A LONG BATTLE WITH CANCER. HE WAS KNOWN AFFECTIONATELY AS "PAPA," "DADIO," "LORENZO," AND "LARRY," BORN AND RAISED IN SIOUX FALLS, SOUTH DAKOTA WHERE HIS FATHER RAN THE DOWNTOWN JEWELRY STORE. SERVED IN THE U.S. ARMY DURING AND JUST AFTER WORLD WAR II STATIONED IN JAPAN. THE G.I. BILL FINANCED HIS EDUCATION AT GRINNELL COLLEGE IN IOWA AND THE UNIVERSITY OF MICHIGAN SCHOOL OF LAW. HE AND HIS YOUNG BRIDE, DORIS, MOVED TO THE SAN FERNANDO VALLEY WHERE HE ESTABLISHED A SUCCESSFUL LAW PRACTICE, OFTEN REPRESENTING ARCHITECTS AND PLUNGED INTO CIVIC AFFAIRS WHERE ARCHITECTURAL PRESERVATION BECAME ONE OF HIS MANY PASSIONS. HIS NUMEROUS HOBBIES INCLUDED WOODWORKING, CHESS, FLYING HIS OWN PLANE, BICYCLING AND MOTORCYCLING TRAVEL AND OF COURSE FOOD. HIS DAUGHTER NANCY IS AN INTERNATIONALLY RENOWNED RESTAURANTEUR, FOUNDER OF LA BREA BAKERY AND NOW RUNS OSTARIA MOZZA AND PIZZERIA MOZZA IN LOS ANGELES AND SEVERAL OTHER CITIES. LARRY'S OTHER INTERESTS INCLUDED LOCAL POLITICS VARIOUS ENVIRONMENTAL AND PROGRESSIVE CAUSES INCLUDING THE SIERRA CLUB NATURE CONSERVANCY, WILDERNESS SOCIETY, HABITAT FOR HUMANITY, THE CARTER CENTER, TREE PEOPLE, AMERICANS FOR PEACE NOW AND J. STREET. HE'S SURVIVED BY HIS TWO SISTERS, RIVA LEVY AND FAY GIBBS, HIS TWO DAUGHTERS NANCY AND GAIL. HIS LONG TIME COMPANION JUDY HELLINGER. HIS GRANDCHILDREN, ANDREAS KRANKL, NIKOLAS KRANKL, ANNIKA KRANKL, VANESSA SILVERTON-PEEL, BENJAMIN SILVERTON-PEEL AND OLIVER SILVERTON-PEEL AND TWO GREAT GRANDCHILDREN. AND, MR. MAYOR, MY COLLEAGUE SUPERVISOR RIDLEY-THOMAS ASKED IF I WOULD ALSO ADJOURN IN THE MEMORY OF ANNE MOODY. MISS MOODY WAS BORN ON SEPTEMBER 15, 1940 IN MISSISSIPPI. PASSED AWAY FEBRUARY 5TH OF THIS YEAR AT THE AGE OF 74. SHE STARTED WORKING WHEN SHE WAS IN FOURTH GRADE TO HELP SUPPORT THE FAMILY, EARNED AN ATHLETIC SCHOLARSHIP TO NATCHEZ JUNIOR COLLEGE, SUBSEQUENTLY EARNED AN ACADEMIC SCHOLARSHIP TO TOUGALOO COLLEGE, A HISTORICALLY BLACK COLLEGE IN MISSISSIPPI. AS A STUDENT, MISS MOODY BECAME INVOLVED WITH THE CIVIL RIGHTS EFFORTS, JOINED THE CONGRESS OF RACIAL EQUALITY ALONG WITH THE N.A.A.C.P. AND BECAME ACTIVE IN ORGANIZING VOTER REGISTRATION EFFORTS, WHICH AS WE KNOW AT THE TIME WAS A FAIRLY DANGEROUS ENTERPRISE. IN 1963, SHE PARTICIPATED IN A STAGED SIT-IN AT TOUGALOO COLLEGE WHEN A MOB ATTACKED AN INTEGRATED GROUP OF STUDENTS JUST AFTER A SUPREME COURT DECISION TO LEGALIZE SIT-INS. SO WE ASK THAT WE ADJOURN IN HER MEMORY. AND, FINALLY, I MOVE THAT WHEN WE ADJOURN TODAY, WE ADJOURN IN MEMORY OF RISE PHILLIPS. MISS PHILLIPS PASSED AWAY ON FEBRUARY 10TH. SHE EARNED A MASTER'S DEGREE IN PUBLIC HEALTH WITH A SPECIALTY IN EPIDEMIOLOGY AND BIO STATISTICS AND A MASTER'S DEGREE IN BUSINESS ADMINISTRATION FROM U.C.L.A. THE JOHN ANDERSON SCHOOL OF MANAGEMENT. SHE HELD SEVERAL EXECUTIVE MANAGEMENT POSITION THIS IS THE PUBLIC AND PRIVATE HEALTHCARE SECTORS INCLUDING THE L.A. COUNTY DEPARTMENT OF HEALTH SERVICES WHERE SHE WORKED TO SUPPORT HOUSING AND PREVENTION INTERVENTIONS IN THE EARLY DAYS OF THE H.I.V./AIDS EPIDEMIC. SHE WAS INTEGRAL TO THE BUSINESS DEVELOPMENT AND PUBLIC POLICY FUNCTIONS AT THE CALIFORNIA FAMILY HEALTH COUNCIL AND WORKED ON LEGISLATION DESIGNED TO SAFEGUARD AND BRING FUNDING IN SUPPORT OF WOMEN'S HEALTH CARE AND REPRODUCTIVE RIGHTS. SHE WAS THE PROJECT DIRECTOR FOR BIOMEDICAL SUPPORT GROUP THAT ENGAGED IN RESEARCH FOR H.I.V. CLINICAL TRIALS WORLDWIDE. IN 2009, SHE JOINED "TO HELP EVERYONE", T.H.E. HEALTH AND WELLNESS CENTERS WHERE SHE LED THE ORGANIZATION TO OPEN SIX LOCATIONS IN JUST A FEW YEARS. MISS PHILLIPS WAS HONORED RECENTLY FOR THE T.H.E. LA BREA SITE, RECEIVED NUMEROUS RECOGNITIONS, INCLUDING FROM THE OFFICES OF THE GOVERNOR, THE LOS ANGELES CITY MAYOR, SENATOR FEINSTEIN, CONGRESSWOMAN KAREN BASS AND SENATOR HOLLY MITCHELL, AMONG OTHERS. SHE WILL LONG BE REMEMBERED FOR HER COMMITMENT FOR THE T.H.E. MISSION FOR BRINGING AFFORDABLE, CARING AND CULTURALLY SENSITIVE HEALTHCARE TO THE COMMUNITIES. SHE'S SURVIVED BY MANY FAMILY FRIENDS AND MEMBERS OF THE COMMUNITY WHO WILL MISS HER GREATLY. THANK YOU, MR. MAYOR. 

SUP. ANTONOVICH, MAYOR: SECOND, WITHOUT OBJECTION, SO ORDERED. SUPERVISOR KNABE? 

SUP. KNABE: THANK YOU, MR. MAYOR, MEMBERS OF THE BOARD. I WOULD ASK THAT WE MOVE AND ADJOURN IN MEMORY OF SARA P. MENDEZ, PASSED AWAY IN NORWALK FEBRUARY 4TH WITH HER LOVED ONES BY HER SIDE. SHE WAS 93. BORN IN TEXAS, MOVED TO SOUTH LOS ANGELES IN 1935. SHE ATTENDED JEFFERSON HIGH SCHOOL WHERE SHE MET HER HUSBAND MARIO. 1951, SHE MOVED TO NORWALK WHERE THEY WOULD RESIDE FOR SOME 64 YEARS. SARAH LOVED BEING INVOLVED IN CHILDREN'S ACTIVITIES. SHE VOLUNTEERED IN MANY DIFFERENT WAYS. SHE WORKED AT SANTA FE HIGH SCHOOL, SERVED AS A TRUSTEE IN THE LITTLE LAKE SCHOOL DISTRICT FOR DECADES. HER SERVICE TO THE COMMUNITIES OF NORWALK AND SANTA FE SPRINGS WAS RECOGNIZED WITH THE DEDICATION OF THE SARA MENDEZ PARK IN THE CITY OF NORWALK. SHE WILL ESPECIALLY BE REMEMBERED FOR HER LOVE OF FAMILY AND HER PASSION FOR IMPROVING THE PUBLIC EDUCATION SYSTEM. SHE WAS A KIND, CARING WOMAN AND WILL BE DEEPLY MISSED. SHE'S SURVIVED BY HER CHILDREN, MARIO, EDWARD, SANDRA, RALPH, ANTHONY, MARC, MARIA AND MY GOOD FRIEND MIKE. HER 15 GRANDCHILDREN, 5 GREAT GRANDCHILDREN. THOUGHTS AND PRAYERS ARE WITH THE FAMILY. ALSO THAT WE ADJOURN IN MEMORY OF LONGTIME FRIEND ANTHONY MARK MARICICH, 80-YEAR RESIDENT OF SAN PEDRO, RETIRED FROM THE CITY OF L.A. AS A FIRE CAPTAIN. HE WAS VERY ACTIVE IN THE COMMUNITY AS A MEMBER OF THE 100-MILE PER HOUR CLUB AS WELL AS THE ELKS CLUB AND THE DALMATION AMERICA CLUB. HE WAS PRECEDED IN DEATH BY BROTHER AND FORMER SAN PEDRO FIELD DEPUTY FOR THE DEANE DANA MITCH MARICICH. HE IS SURVIVED BY WIFE LOUISE, DAUGHTER TONI, BROTHER NICHOLAS, SISTER-IN-LAW DIANNE, A HOST OF NIECES AND NEPHEWS. WE'D LIKE TO EXTEND OUR CONDOLENCES TO THE FAMILY. ALSO ADJOURN IN MEMORY OF JULIO FAJARDO, WHO PASSED AWAY FEBRUARY 11TH, HE IS SURVIVED BY HIS DAUGHTER TESS. HE WILL BE MISSED BY HIS FAMILY AND FRIENDS. FINALLY, THAT WE ADJOURN IN MEMORY OF RALPH WOOD, JR., OWNER OF THE WORLD FAMOUS ADMIRAL RISTY RESTAURANT IN RANCHO PALOS VERDES, AN ICON THERE. HE PASSED AWAY AWAY AT THE AGE OF 90 ON JANUARY 25TH. HE GREW UP IN PASADENA AFTER GRADUATING FROM HIGH SCHOOL HE SERVED IN THE ARMY IN GERMANY DURING WORLD WAR II, MARRIED HIS HIGH SCHOOL SWEETHEART BARBARA, THEY WERE MARRIED FOR 67 YEARS. HE OWNED AND OPERATED MORE THAN 23 RESTAURANTS IN HIS LIFETIME. HE AND HIS WIFE WERE AVID SAILORS AND ACTIVE IN THE KING HARBOR YACHT CLUB OFTEN TAKING THEIR FOUR CHILDREN CAMPING AND FISHING TO THE EASTERN SIERRA. THEY TRAVELED TO EVERY CONTINENT WITH THE EXCEPTION OF AUSTRALIA. HE IS SURVIVED BY HIS FOUR CHILDREN, JON, SARA, CHIP, AND ERIC, MANY GRANDCHILDREN AND GREAT GRANDCHILDREN. HE WILL BE GREATLY MISSED BY ALL WHO KNEW HIM. THOSE ARE MY ADJOURNMENTS. 

SUP. ANTONOVICH, MAYOR: SECOND WITHOUT OBJECTION, SO ORDERED. ITEM NO. 2, SUPERVISOR SOLIS AND KNABE HAD HELD THAT. SUPERVISOR SOLIS? 

SUP. SOLIS: THANK YOU, MR. MAYOR. I'D LIKE TO THANK YOU ALSO FOR ALLOWING ME TO COAUTHOR THIS MOTION WITH YOU. I BELIEVE IT'S ONE THAT'S VERY TIMELY AS WE ARE MOVING THE COUNTY TOWARDS A MORE USER-FRIENDLY PERMITTING PROCESS. I THINK THIS PARTICULAR ITEM HELPS TO ADDRESS THAT. AS YOU CURRENTLY KNOW, RIGHT NOW, MANY BUSINESSES HAVE TO GO INTO THE REGIONAL PLANNING OFFICE DOWNTOWN LOS ANGELES AND OTHERS HAVE TO GO TO THE PUBLIC WORKS IN ALHAMBRA AND FIRE IN COMMERCE AND PUBLIC HEALTH IN BALDWIN PARK. THE COUNTY DOESN'T HAVE A REGIONAL ONE-STOP DEVELOPMENT CENTER THAT HOUSES ALL FOUR AGENCIES. I'VE SEEN SOMETHING SIMILAR TO THAT LOCATED ACTUALLY IN EAST LOS ANGELES. I'M HOPING THAT TOGETHER WE CAN BEGIN TO LOOK AT PROVIDING RELIEF FOR OUR SMALL BUSINESSES AND HOMEOWNERS THAT NEED TO GET THEIR PERMITS EXPEDITED QUICKLY. IT TAKES A LOT FOR THEM TO GO THROUGH THE PROCESS. AND CERTAINLY IT WOULD BEHOOVE US TO BEGIN TO LOOK AT THE ONE STOP DEVELOPMENT COMPONENT. SO I VERY MUCH AM IN SUPPORT OF THIS. 

SUP. ANTONOVICH, MAYOR: THANK YOU, SUPERVISOR KNABE? 

SUP. KNABE: YEAH, I AM, TOO. AND I WOULD LIKE TO JUST HAVE A FRIENDLY AMENDMENT. "LAST MONTH, THE BOARD TRANSFERRED THE COUNTY'S OFFICE OF SMALL BUSINESS TO BE RENAMED THE 'DEPARTMENT OF CONSUMER AND BUSINESS AFFAIRS' AND BUILD UPON THEIR OUTREACH NETWORK TO NOT ONLY SERVE OUTREACH TO CONSUMERS OF LOS ANGELES COUNTY BUT MOST IMPORTANTLY TO OUR SMALL BUSINESSES. ONE OF THE NEW FUNCTIONS-- AND WE BROUGHT IN THE MOTION SUPPORTED BY THE BOARD, IS THE SMALL-BUSINESS CONCIERGE AND WHO WOULD ACT AS A SINGLE POINT OF CONTACT FOR SMALL BUSINESSES SEEKING ASSISTANCE FROM OUR VARIOUS COUNTY DEPARTMENTS, INCLUDING PUBLIC WORKS, REGIONAL PLANNING AND FIRE." SO I THINK IT'S VERY IMPORTANT THAT THE D.C.B.A. BE INCLUDED IN THIS STUDY SINCE THEY WILL BE WORKING DIRECTLY WITH THESE PERMITTING DEPARTMENTS. SO I WOULD JUST ASK AND DIRECT THAT THE DEPARTMENT OF CONSUMER AND BUSINESS AFFAIRS BE INCLUDED IN THIS ANALYSIS. 

SUP. ANTONOVICH, MAYOR: THAT WILL BE INCLUDED. ALSO, TO "DIRECT THE DEPARTMENT OF PUBLIC WORKS TO REPORT BACK TO THE BOARD TO CONSIDER PLAN ENHANCEMENTS TO THEIR EXISTING ELECTRONIC PERMIT PROCESSING SYSTEM." YOU KNOW, RIGHT NOW, SMALL BUSINESS PERSON, IT'S NOT UNCOMMON THAT THEY HAVE TO GO DOWNTOWN TO THE PLANNING. THEN THEY HAVE TO GO TO ALHAMBRA FOR PUBLIC WORKS. THEN THEY HAVE TO DRIVE OUT TO COMMERCE TO SEE THE FIRE DEPARTMENT. AND THEN THEY WIND UP AT BALDWIN PARK TO SEE PUBLIC HEALTH. WELL IT'S AN INCONVENIENCE TO THE CONSUMER, BUT IT'S ALSO AN INCONVENIENCE TO THE WORK STAFF BECAUSE HERE YOU'RE NOW GOING TO REPLACE THAT WITH ONE LOCATION WHERE THE COUNTY STAFF CAN EACH COMMUNICATE DIRECTLY WITH ONE ANOTHER, RESOLVE THOSE PERMIT AND POLICY ISSUES QUICKLY AND CREATE UNIFORM TIME FRAMES FOR THE PERMIT PROCESSING. SO EVERYBODY BENEFITS FROM THAT. 

SUP. KNABE: IF I COULD JUST ADD. 

SUP. ANTONOVICH, MAYOR: SUPERVISOR? 

SUP. KNABE: I TOTALLY AGREE WITH YOUR COMMENTS HAVE I THINK IT'S REALLY IMPORTANT. I DON'T KNOW WHAT THE APPROPRIATE TIME IS, BUT AT SOME POINT WE'RE GOING TO HAVE TO DEAL WITH THE ISSUE OF THE 9-80S AND 4-40S AND MAYBE CREATE AN OVERLAP SITUATION SO WE HAVE WHEN WE'RE COLOCATING WE HAVE PEOPLE WE CAN TALK TO FIVE DAYS A WEEK. 

SUP. ANTONOVICH, MAYOR: THAT COULD BE INCLUDED. 

SUP. KNABE: I THINK THIS SHOULD BE PART OF THIS STUDY. NOT TO TAKE IT AWAY AND EVERYBODY GO NUTS THAT WE'RE TRYING TO TAKE AWAY -- BUT THERE SHOULD BE A WAY TO OVERLAP THAT SO THESE OFFICES ARE OPEN FIVE DAYS A WEEK. 

SUP. SOLIS: I AGREE. 

SUP. ANTONOVICH, MAYOR: MR. PREVEN AND MR. SACHS? 

ARNOLD SACHS: THANK YOU, ONE MINUTE AND TIME IT'S OFF TO THE RACES. 20 YEARS? RIDLEY-THOMAS, THERE'S NO NUMBER TO PUT ON HIS YEARS, BUT WHY ALL OF A SUDDEN THIS IS COMING TO LIGHT WOULD BE A QUESTION TO ASK THESE SILOS THAT YOU CREATE FOR THE BUSINESS COMMUNITY, THEY KIND OF LIKE ECHO THE SILOS THAT WE HEAR ABOUT WITH THE OTHER DEPARTMENTS, YOU KNOW, D.C.F.S. WORKING WITH D.H.S. AND THE PROBLEMS THAT EXIST THERE. WHAT THIS ACTUALLY, A GOOD DOCTOR WOULD LOOK AT IT AND DIAGNOSE IT AS JUST POOR LEADERSHIP, THAT YOU HAVE THESE DIFFERENCES THAT THE PATIENTS ALWAYS SUFFER. A GOOD DOCTOR WOULD SAY: TIME TO CHANGE THE LEADERSHIP. GET A SECOND OPINION ON YOUR DOCTOR. 

ERIC PREVEN: YEAH, IT'S ERIC PREVEN, COUNTY PRESIDENT FROM DISTRICT 3 AND ITEM 2 TODAY, WHICH IS IF I'M NOT MISTAKEN, IT'S THE ELECTRONIC PERMIT SYSTEM THAT'S BEING AUDITIONED? NO, IT'S NOT? OH GOD, THAT'S EMBARRASSING. IT IS NOT. WAIT. IT SAYS UPDATE PROGRESS ON IMPLEMENTING THEIR ELECTRONIC PERMIT PROCESSING SYSTEM. THAT IS ITEM 2? IS THAT ACCURATE? 

SUP. ANTONOVICH, MAYOR: THAT'S PART OF IT. 

ERIC PREVEN: BUT THE REAL ISSUE HAD TO DO WITH REGIONAL PLANNING MOVING ITS FACILTY? 

SUP. ANTONOVICH, MAYOR: YES, YES. 

ERIC PREVEN: THAT'S WHY IT WAS A LITTLE BIT OF A WHOO, I WAS A LITTLE CONFUSED. I ASKED BRUCKNER ABOUT THAT. I SAID "HEY, ARE YOU MOVING OFFICES? IS THAT HAPPENING?" HE SAID "I DON'T KNOW. I DON'T WANT TO TALK ABOUT IT." SO WE COULD TALK ABOUT IT. IT DOES MAKE SENSE IF THEY'RE VACATING A FACILITY. BUT PUBLIC WORKS HAS A VERY NICE SET OF OFFICES AS WE LEARNED. AND IT'S REALLY AS GAIL WILL CONFIRM, IT'S A FIVE-STAR PROJECT. ARE WE PLANNING TO MOVE THEM INTO THAT FACILITY? OR IS THIS A NEIGHBORING? OKAY. SO I MISUNDERSTOOD THE ITEM. IT'S MY FAULT BUT IT'S WEIRDLY LABELED BECAUSE IT SURE LOOKS LIKE IT'S ABOUT THE PERMIT PROCESSING SYSTEM. 

SUP. ANTONOVICH, MAYOR: THANK YOU. SO MOVED. SECONDED BY SUPERVISOR SOLIS WITHOUT OBJECTION SO ORDERED AS AMENDED. AND ITEM NO. 3, SUPERVISOR SOLIS. 

SUP. SOLIS: THANK YOU, MR. MAYOR. I'M VERY INTERESTED IN ADDRESSING THE POPULATION OF FERAL CATS AND UNWEANED KITTENS BECAUSE IT'S A GROWING CONCERN IN AT LEAST THE FIRST DISTRICT AND PROBABLY I'M CERTAIN IN OTHER PARTS OF THE COUNTY. IT'S A GROWING DAILY PROBLEM THAT I DON'T THINK IS BEING ADEQUATELY ADDRESSED. IN FISCAL YEAR '13 AND '14, THE BALDWIN PARK CENTER TOOK IN 2,789 UNWEANED KITTENS WHICH REPRESENTS ABOUT 33 PERCENT OF INCOMING CATS. AND AN ADDITIONAL 2,222 FERAL CATS, WHICH REPRESENTED ABOUT A 26 PERCENT OF CATS AT THE BALDWIN PARK CARE CENTER. I COAUTHORED THIS MOTION WITH YOU, MR. MAYOR, BECAUSE I WANT TO BRING THE ATTENTION TO THE DEPARTMENT OF ANIMAL CARE AND CONTROL TO DO MORE TO EDUCATE OUR PUBLIC ON THE ISSUE. AS YOU KNOW, WE HAVE SUCH A DIVERSE POPULATION. AND SOMETIMES INFORMATION IN ONE LANGUAGE DOESN'T REACH ALL COMMUNITIES. SO IT IS IMPORTANT TO ALSO PROVIDE THAT AS A COMPONENT, THAT WE REACH OUT TO ALL THESE COMMUNITIES. AND OF PARTICULAR INTEREST TO ME IS THE GROWING LATINO POPULATION IN CALIFORNIA THAT HAS TAKEN SO KINDLY TO OUR PETS. I MEAN, THOSE ARE BIG SIGNIFICANT PART OF OUR HOUSEHOLDS AND HAS BEEN. BUT IT'S INCREASING. AND YOU CAN SEE IT IN JUST THE BUSINESSES THAT ARE POPPING UP IN OUR COMMUNITIES, ESPECIALLY IN THE FIRST DISTRICT. AND ACCORDING TO PET BUSINESS, A PUBLICATION DEVOTED TO HELPING PET RETAILERS, LATINOS, IT TURNS OUT, ARE A KEY DRIVER IN PET OWNERSHIP IN RATES IN THE U.S., AND WILL BE IN THE U.S. IN THE FUTURE. U.S.-BORN GENERATIONS OF LATINOS, AS THEY GROW IN NUMBERS, THEIR PET OWNERSHIP IS ALSO GROWING, MAKING MARKETING EXPERTS AND OTHERS TO TAKE NOTE OF THAT TREND AND TO UNDERSTAND HOW TO OUTREACH TO OUR COMMUNITY. SO IF THEY CAN DO IT, I THINK THE COUNTY CAN DO IT. SO I VERY MUCH APPLAUD YOU ON YOUR EFFORTS TO DO THAT. 

SUP. ANTONOVICH, MAYOR: SO THE REPORT BACK ON HOW WE COULD REACH ALL OF OUR VARIOUS COMMUNITIES. AND I WOULD ALSO ADD THAT THE 88 CITIES RECEIVE A COPY, AS WELL, OF THE ORDINANCE WHEN IT COMES BACK AND WE DISCUSS IT AND DEBATE IT SO THAT THEY ARE INFORMED, ENCOURAGING THEM TO ADOPT SIMILAR ORDINANCES. BUT SUPERVISOR KUEHL? 

SUP. KUEHL: MR. MAYOR, IN THE ORDINANCE THAT RELATES TO MANDATORY SPAYING AND NEUTERING OF DOGS, IT'S MANDATORY. AND IS THERE A FINE IF IT'S NOT DONE? OR ARE WE SIMPLY DOING OUTREACH AND ENCOURAGING IT? 

SUP. ANTONOVICH, MAYOR: I CAN'T -- HERE'S THE DIRECTOR. OKAY. 

SUP. KUEHL: EXCELLENT. SORRY. I SHOULD HAVE DIRECTED THE QUESTION TO YOU. THAT WAS JUST TO GIVE YOU TIME TO GET UP HERE. SO I'M NOT FAMILIAR WITH THE DETAILS OF THE CURRENT ORDINANCE RELATED TO DOGS. 

MARSHA MAYEDA: THANK YOU, SUPERVISOR. THE BOARD OF SUPERVISORS PASSED AN ORDINANCE IN 2006 REQUIRING SPAY AND NEUTER AND MICROCHIPPING OF DOGS. SO THAT'S BEEN ON THE BOOKS FOR SOMETIME NOW. 

SUP. KUEHL: WHEN THIS CAME TO US IN THE STATE, I HAD CONCERNS ABOUT MAKING IT MANDATORY STATEWIDE BECAUSE IT HAD FINES IN IT, WHICH I ASSUME IS THE ONLY WAY YOU ACTUALLY ENFORCE SOMETHING IF IT'S MANDATORY. AND THERE WERE AT LEAST 50 PERCENT OF PEOPLE IN OUR DISTRICT COULDN'T REALLY AFFORD SOMETIMES SPAYING AND NEUTERING AND THEREFORE ALSO COULDN'T AFFORD THE FINES. IT KIND OF BOTHERED ME TO MAKE SOMETHING MANDATORY WHEN THESE ARE ANIMALS, AS YOU INDICATED, THEY'RE PART OF OUR FAMILY. AND MANY OF OUR LOW INCOME FAMILIES, I'M NOT SURE HOW THAT'S TAKEN CARE OF. DO WE HAVE SOME KIND OF PROGRAM THAT HELPS PEOPLE AFFORD IT? 

MARSHA MAYEDA: WE DO. WE HAVE A LOW-COST SPAY/NEUTER VOUCHER PROGRAM FOR DOGS. THE VOUCHERS ARE $50. AND THEY CAN APPLY THAT TO A PRIVATE VETERINARIAN TO REDUCE THE BILL OR THEY CAN REDEEM IT AT ONE OF OUR ANIMAL CARE CENTERS. AND OUR FEE IS $50. SO THEY, IN ESSENCE, GET IT AT NO COST. 

SUP. KUEHL: SO THIS WOULD HAVE A BUDGETARY IMPACT. I ASSUME THAT'S PART OF THE REPORT BACK TO US ON THIS ORDINANCE. I REALLY FAVOR IT, I'M STRONGLY FOR IT. BUT I WANT TO MAKE CERTAIN THAT IF YOU'RE ORDERING PEOPLE TO DO THINGS, THEY CAN ACTUALLY AFFORD TO DO IT. 

MARSHA MAYEDA: RIGHT. 

SUP. KUEHL: THANK YOU, MR. MAYOR. 

SUP. ANTONOVICH, MAYOR: WE HAVE ONE SPEAKER, MR. SACHS? 

SUP. KNABE: WE CAN START THE POPULATION COUNT OUT AT RANCHO. 

ARNOLD SACHS: YES, THANK YOU VERY QUICKLY. ARNOLD SACHS. THIS ORDINANCE, IT'S NOT FOR THE 88 CITIES, THOUGH. IT'S NOT -- 

SUP. ANTONOVICH, MAYOR: NOBODY SAID IT WAS. 

ARNOLD SACHS: I'M JUST ASKING, SIR. SO IT JUST ACTUALLY REFERS TO THE UNINCORPORATED AREA. WHICH IS SOMEWHAT LIMITED IN AND OF ITSELF. 

SUP. ANTONOVICH, MAYOR: A MILLION AND A HALF PEOPLE LIVE IN UNINCORPORATED AREAS. IT WOULD BE THE SECOND LARGEST CITY IN THE LOS ANGELES AREA. 

ARNOLD SACHS: OUT OF THE 10 MILLION PEOPLE THAT LIVE IN THE COUNTY. AND HOW MANY COUNTY ANIMAL CARE CENTERS? DOES EACH UNINCORPORATED AREA OR EACH DISTRICT HAVE AN ANIMAL CARE CENTER IN ITS UNINCORPORATED AREAS FOR THESE PEOPLE TO UTILIZE THESE VOUCHERS MISS SOLIS? HAVE YOU EVER BEEN TO A VOTING POLL? IF THEY CAN DO 11 LANGUAGES FOR YOUR ELECTION, YOU CAN DO 11 LANGUAGES FOR THIS INFORMATION. IT'S NO BIG DEAL. GO TO ELECTION SOMETIME AND READ THE KIOSKS THAT THEY PUT UP THERE. IT'S LIKE 11 LANGUAGES THAT YOU HAVE TO HAVE. WHY CAN'T YOU DO THAT FOR SPAY AND NEUTERING? 

SUP. ANTONOVICH, MAYOR: WE'LL HAVE TO VOTE SOMETIME AND FIND OUT HOW THAT WORKS. [LAUGHTER.] OKAY. MOTION SOLIS, SECOND WITHOUT OBJECTION, AS AMENDED, SO ORDERED. OKAY. ITEM NO. 34, 35, 36 ARE ALL TOGETHER. THAT'S A DISCUSSION ITEM. THIS WILL BE ON RISK MANAGEMENT. 

STEVEN ESTABROOK: GOOD AFTERNOON, MR. MAYOR, MEMBERS OF THE BOARD. TO MY RIGHT IS STEVE ROBLES, HE'LL BE PRESENTING THE C.E.O. RISK MANAGEMENT REPORT. MY NAME IS STEVE ESTABROOK AND I'LL BE PRESENTING THE LITIGATION, THE ANNUAL LITIGATION REPORT. THIS YEAR, THE COUNTY SPENT $95.6 MILLION ON OVERALL LITIGATION EXPENSES. AS YOU CAN SEE, IT'S UP FROM LAST YEAR 6.6 MILLION, OR NEARLY 7-1/2 PERCENT. I MUST NOTE THAT THE 89 MILLION THAT WERE SPENT LAST YEAR WAS THE LOWEST AMOUNT SPENT IN THE LAST EIGHT FISCAL YEARS. SO IF WE LOOK AT THE PREVIOUS YEAR, JUST TWO YEARS AGO, WHICH IS '11/'12 WHERE WE SPENT 115.2 MILLION, WE HAD A REDUCTION COMPARED TO THAT YEAR OF 17 PERCENT. OVER THE LAST FIVE YEARS, INCLUDING THE EIGHT-TIME ALL-TIME LOW OF 89 MILLION, THE AVERAGE, THE FIVE-YEAR AVERAGE WAS $102 MILLION, WHICH THIS YEAR'S COST AND EXPENSES WERE 6.3 PERCENT LESS THAN THAT AMOUNT. THE $95.6 MILLION CAN BE DIVIDED INTO TWO COMPONENTS: JUDGMENTS AND SETTLEMENTS AND ATTORNEYS' FEES AND COSTS. LET'S TAKE JUDGMENTS AND SETTLEMENTS FIRST. JUDGMENTS WERE 5.8 MILLION AND SETTLEMENTS WERE 34.5 FOR A TOTAL OF 40.3 MILLION. AND SETTLEMENTS ARE WHEN WE DECIDE THE RISK IS TOO HIGH OR THE NUISANCE VALUE IS NOT WORTH LITIGATING THE CASE, JUDGMENTS ARE WHEN A COURT AS YOU KNOW OR JURY DIRECT US TO MAKE PAYMENT. JUDGMENT AS I SAID 5.8 MILLION. AND WE HAD 10 JUDGMENTS AGAINST US IN '13/'14. THIS NUMBER, THE 5.8 WAS THE LOWEST AMOUNT PAID IN JUDGMENTS IN THE LAST 8 FISCAL YEARS. ONLY TWO OF THOSE JUDGMENTS EXCEED $1 MILLION. BOTH OF THOSE WERE EXCESSIVE FORCE CASES. THE FIRST WAS AN APARTMENT MANAGER WHO CONTENDED THAT HE DID NOT RESIST ARREST OUT IN PALMDALE AND THE OFFICERS, THE DEPUTIES INDICATED THAT HE DID. AND THAT WAS THE ISSUE IN THE CASE. A CRIMINAL TRIAL PRECEDED THE CIVIL TRIAL AND THE CRIMINAL JURY FOUND HIM NOT GUILTY. THAT WAS USED IN THE UNDERLYING CIVIL CASE. AND THE JURY FOUND THAT THERE WAS EXCESSIVE FORCE USED BY ONE OF THE THREE DEPUTIES. AND WE PAID $2.45 MILLION. THE SECOND CASE WAS A SHOOTING EXCESSIVE FORCE CASE. AND THIS INVOLVED SUSPECTS OUT AT THE AZUSA AREA, UNINCORPORATED AREA OF THE COUNTY. AND THEY WERE BURGLARY SUSPECTS. WHEN THE DEPUTIES CAME ON THE SCENE, THE SUSPECTS FLED. ONE RAN TO A FENCE. COULD NOT JUMP THE FENCE. TURNED AND FACED THE DEPUTY WITH A 9-INCH BLADE. THERE WERE SHOTS FIRED. IN FACT, FIVE. AND TWO OF THE SHOTS ENTERED THE SUSPECT IN THE BACK AND HE WAS KILLED. HIS PARENTS SUED CLAIMING THAT HE WAS SHOT IN THE BACK AND THE JURY AWARDED THE PARENTS $2.1 MILLION. THE SETTLEMENTS, WE HAD 194 SETTLEMENTS FOR A TOTAL OF $35.5 MILLION. SEVEN OF THE SETTLEMENTS WERE OVER $1 MILLION. AND THEY TOTALED 19.1 MILLION. THE FIRST LARGE SETTLEMENT WAS 7.5 MILLION. IT'S THE WELCH CASE. IT'S THE HEALTH SERVICES CASE. A MEDICAL MALPRACTICE MATTER WHERE A PREGNANT WOMAN CAME TO LAC+USC WITH ABDOMINAL PAIN. SHE WAS DIAGNOSED WITH HAVING FALSE LABOR AND RECEIVED A MUSCLE RELAXANT AND WAS RELEASED. SHE RETURNED SEVERAL HOURS LATER AND IT WAS DETERMINED DURING HER CESAREAN SECTION THAT HER UTERUS HAD RUPTURED. AND WE SETTLED THAT CASE FOR 7.5 MILLION. ANOTHER HEALTH SERVICES CASE, HOWEVER, THIS ONE WAS AN AUTO CASE, A HEALTH SERVICES EMPLOYEE WAS EXITING A GAS STATION AND BROADSIDED MR. PEREZ. HE UNFORTUNATELY, HIS VEHICLE ROLLED AND HE LOST ALL FOUR FINGERS ON HIS DOMINANT HAND AND WE SETTLED THAT CASE FOR 4 MILLION. THIRD HEALTH SERVICES CASE WAS A CASE THAT GOES BACK SEVERAL YEARS. IT'S THE WORKS CASE. AND THIS WAS AN INMATE WHO WAS PREGNANT WITH TWINS AND RECEIVED MEDICAL SERVICES AT LAC+USC WHILE INCARCERATED. SHE WAS DIAGNOSED WITH AN INFECTION, AN INTRAUTERINE INFECTION. AFTER THAT DIAGNOSIS, UNFORTUNATELY THAT DID NOT MAKE ITS WAY BACK TO THE JAIL PHYSICIAN, AND SHE WAS SUPPOSED TO RECEIVE BED REST. SHE DELIVERED HER TWINS, ONE DIED UNFORTUNATELY. THE OTHER HAD SERIOUS NEUROLOGICAL INJURIES. THAT CASE WAS SETTLED FOR $5 MILLION. TWO YEARS AGO, WE PAID 3 MILLION. THIS IS THE REST OF THAT PAYMENT. IT WAS SHARED BETWEEN THE HEALTH SERVICES AND SHERIFF 60/40 PERCENT. THE ENG CASE WAS AN EXCESSIVE FORCE SHOOTING CASE. THIS WAS A YOUNG WOMAN IN A FAMILY CENTER WHO THE DEPUTIES WERE SUMMONED BECAUSE SHE WAS IN THE WAITING ROOM WITH A HAMMER. SHE ADVANCED UPON THE DEPUTIES ONCE THEY ARRIVED. THEY TRIED TO TASER HER. THAT DID NOT STOP HER ADVANCE. SHE WAS SHOT ONCE AND THAT DID NOT STOP HER AND IT WAS THE SECOND SHOT. AND THE DEPUTY THAT WAS THE SHOOTING DEPUTY WAS VERY LARGE. THAT CASE SETTLED AND SHE WAS EXTREMELY SMALL. IT WAS SETTLED FOR 1.8 MILLION. THIS WAS A FIRE CASE, THE GUTIERREZ CASE. THE PARAMEDICS ARRIVED, AND WE'RE TOLD THAT A THREE-YEAR-OLD GIRL HAD FALLEN AND HIT HER HEAD. THEY DID NOT TRANSPORT HER TO THE LOCAL HOSPITAL. HOURS LATER, SECOND TEAM OF PARAMEDICS CAME TO THE SAME LOCATION AND DID TRANSPORT THE YOUNG PATIENT. HOWEVER, SHE HAD SOME NEUROLOGICAL DIFFICULTIES AND WE SETTLED THAT CASE FOR $3.8 MILLION. AND 1.4 WAS PAID THIS YEAR. COMMUNITIES ACTIVELY LIVING WAS BROUGHT BY PUBLIC INTEREST ADVOCATE ON BEHALF OF THE DISABLED CLAIMING THAT THE COUNTY'S EMERGENCY RESPONSE PREPAREDNESS DID NOT TAKE THE DISABLED INTO CONSIDERATION. WE CHOSE NOT TO FIGHT THAT. WE CHOSE TO FIX IT. AND SO WE SPENT A GREAT DEAL OF TIME NEGOTIATING AND WORKING THE DISABLED INTO OUR EXISTING EMERGENCY RESPONSE PLAN. IT'LL BE A SIX-YEAR PROJECT COSTING THE COUNTY $3 MILLION, AFTER WHICH THE DISABLED WILL BE INCORPORATED INTO OUR PLAN. HOWEVER, PUBLIC ADVOCATES DO HAVE ATTORNEYS, AND WE DID HAVE TO PAY THEIR ATTORNEYS, WHICH WAS THE 1.225 MILLION. THE FINAL CASE WAS A CUSTODY EXCESSIVE FORCE CASE. HOWEVER, THIS WAS NOT AN INMATE. THE PLAINTIFF WAS THE BROTHER OF AN INMATE. AND HE CLAIMED THAT HE DID NOT RESIST AFTER HE WAS ARRESTED IN THE JAIL WHILE VISITING. HE WAS ARRESTED FOR HAVING A CELL PHONE. HE CLAIMED THAT HE DID NOT RESIST. THE DEPUTIES CLAIM THAT HE DID. WE SETTLED THE CASE FOR 1.175 MILLION. THOSE ARE THE SEVEN CASES. NOW, EVERY YEAR -- AND THIS YEAR IS NO DIFFERENT -- AT THE END OF THE YEAR, THERE ARE CASES THAT WE HAVE SETTLED AND THE BOARD, THIS BOARD HAS APPROVED BUT WE DON'T PAY THEM. THESE ARE ALL THE EXPENSES THAT WE'VE PAID. SO THIS YEAR, THERE WERE 4.8 MILLION IN PROVED CASES THAT WERE NOT PAID THIS YEAR. SO I WANTED TO NOTIFY OF YOU OF THAT. TWO OF THEM EXCEEDED 1 MILLION. WE'VE ALREADY TALKED ABOUT THE GUTIERREZ CASE, THAT'S THE YOUNG THREE-YEAR-OLD WITH THE HEAD INJURY AND SHE HAD A BRAIN BLEED, WHICH IS WHY THE CASE SETTLED FOR 3.8 MILLION. AND THE SECOND CASE WAS A MEDICAL MALPRACTICE LABOR AND DELIVERY CASE WHERE THERE WAS DELAYED TREATMENT AND THE PATIENT SUFFERED A STROKE DURING DELIVERY. THAT SETTLED FOR 1.5 MILLION. AND 500,000 WAS PAID THIS YEAR, ANOTHER MILLION WILL BE PAID NEXT YEAR. THE OTHER COMPONENT OF COST FOR IN LITIGATION ARE CONTRACT COUNSEL AND COUNTY COUNSEL FEES. CONTRACT COUNSEL FEES THIS YEAR WERE 42.9 MILLION. THOSE ARE OUTSIDE COUNSEL. OUR IN-HOUSE COUNTY COUNSEL WERE 12.4 MILLION. AND THAT INCLUDES NOT JUST THEY LITIGATE CASES IN COURT THEMSELVES, THAT'S COUNTY COUNSEL. BUT THEY ALSO OVERSEE THE CONTRACT COUNSEL. THIS YEAR THE CONTRACT COUNSEL CAN BE BROKEN DOWN INTO FEES AND COSTS. COSTS ARE EXPERTS, COURT REPORTERS AND THE LIKE. FEES ARE FOR SERVICES BY THE ATTORNEYS. THE OUTSIDE FEES WERE UP $2.8 MILLION THIS YEAR. THAT WAS LARGELY IN THE AREA OF EMPLOYMENT AND LAW ENFORCEMENT. COSTS WERE UP ABOUT $300,000. THIS YEAR, AT THE BEGINNING OF THIS FISCAL YEAR, THE LOS ANGELES SUPERIOR COURT CONSOLIDATED, AND ALONG WITH THAT CONSOLIDATION, THEY ELIMINATED COURT REPORTERS. WE NOW HAVE TO PAY FOR ALL OF OUR COURT REPORTERS. MUCH OF THE INCREASE THERE WAS ATTRIBUTED TO THAT. THIS WAS THE TYPE OF CHART WE LIKE TO SEE. THIS IS COUNTY COUNSEL'S FEES AND COSTS. AS YOU CAN SEE, IT'S GOING DOWN BY A MILLION DOLLARS AND HAS FOR THE LAST TWO YEARS. THE FEES ARE 11.2. THOSE WENT DOWN 1.3 MILLION. THE COSTS, HOWEVER, ROSE BY ABOUT 300,000. AGAIN, ATTRIBUTED TO THE SUPERIOR COURT CONSOLIDATION. NOW, I WANTED TO POINT OUT THAT EVERY YEAR WE DO HAVE CONTRACT CITIES CASES. AND IN THOSE CASES, THE CITIES UTILIZE DEPUTY SHERIFFS. AND WHEN THEY DO, ANY LIABILITY THAT STEMS FROM THAT IS PAID BY THE CONTRACT CITIES. AND THE CONTRACT CITIES THIS YEAR, TOGETHER WITH SPECIAL DISTRICTS, INCLUDING THE TWO WATER DISTRICTS, THE FLOOD CONTROL DISTRICT, THEY PAID 12 MILLION OF THE 95.6. SO THE MONEY THAT CAME ACTUALLY FROM THE COUNTY WAS 83.6. AND WE HAD A BETTER-THAN-AVERAGE YEAR THIS YEAR. NOW, THESE ARE THE TOP 10 DEPARTMENTS IN THE COUNTY THAT PAID THE MOST IN TERMS OF LITIGATION COSTS. I KNOW THERE'S A LOT OF NUMBERS AND NAMES UP HERE. LET ME HELP YOU BRIEFLY. ON THE LEFT IN THE RED SQUARE ARE THE DEPARTMENTS RUNNING FROM THE SHERIFF DOWN TO THE DISTRICT ATTORNEY. THESE DEPARTMENTS MAKE UP 90 PERCENT, OR SPEND 90 PERCENT OF OUR LITIGATION EXPENSES. THE NEXT COLUMN IS LAST YEAR, '12/'13. THE HIGHLIGHTED COLUMN IS THIS YEAR. AND THE COLUMN ON THE RIGHT ARE THE CHANGES. IN THE RED, THAT'S A REDUCTION. AND YOU CAN SEE THAT THE SHERIFF'S DEPARTMENT REDUCED THEIR LITIGATION EXPENSES THIS YEAR BY 2.3 MILLION. THE DEPARTMENT OF PUBLIC WORKS LIKEWISE REDUCED THEIR EXPENSES. THREE DEPARTMENTS, HEALTH SERVICES, FIRE DEPARTMENT AND THE PUBLIC HEALTH, THEIR EXPENSES ROSE THE MOST THIS YEAR. NOW LET'S TAKE A LOOK AT -- NOW, FIVE OF THESE DEPARTMENTS, THE TOP FIVE, SHERIFF, HEALTH SERVICES, PUBLIC WORKS, FIRE DEPARTMENT, CHILDREN AND FAMILY SERVICES, THEIR EXPENSES TOTALED 80 PERCENT. LET'S TAKE A QUICK LOOK AT THOSE. FIRST IS THE SHERIFF. THEIR COST DRIVER IS LAW ENFORCEMENT. AND THE CROSSHATCHED AREA REPRESENTS EXCESSIVE FORCE, WHICH IS THE BIGGEST AREA OF EXPENSE IN THE LAW ENFORCEMENT AREA FOR THE SHERIFF. THEY ALSO TREAT INMATES. SO THEIR MEDICAL MALPRACTICE WHICH IS ON THE RIGHT ROSE BY 800,000. 40.7 IS WHAT THE SHERIFF SPENT TOTAL FOR ALL THEIR EXPENSES. 32.7 REPRESENTS THAT PORTION WHICH IS THE LAW ENFORCEMENT. AND THAT'S 80 PERCENT OF WHAT THEY SPEND GOES TO LAW ENFORCEMENT. OF THAT, 24.2 OF THE 32.7 GOES TO EXCESSIVE FORCE. AND EXCESSIVE FORCE CAN BE DIVIDED INTO PATROL AND CUSTODY. 18.4 MILLION WAS SPENT ON EXCESSIVE FORCE CASES ON PATROL OR ON THE STREET. THE OTHER 5.8 WAS ON CUSTODY CASES. THE OTHER AREA WHERE THE SHERIFF PROVIDES SERVICES IS MEDICAL MALPRACTICE WITH THEIR MEDICAL PERSONNEL IN THE JAILS. AND IT WAS UP, AS I SAID, 800,000. TWO CASES. WE'VE ALREADY TALKED ABOUT THE WORKS CASE WHICH IS THE LABOR AND DELIVERY CASE. THIS WAS THE SHERIFF'S PERCENTAGE PAYMENT OF THAT CASE. GARCIA INVOLVED ANOTHER INMATE IN THE COUNTY JAIL WHO HE CONTENDED THERE WAS A DELAY IN TREATMENT IN HIS GENITAL AREA. AND WE SETTLED THAT CASE FOR $150,000 AND FEES AND COSTS ACCOUNTED FOR THE REST OF THE $300,400. NOW THESE ARE THE CHARTS THAT WE ALSO LIKE TO SEE. IF YOU LOOK EMPLOYMENT ON THE LEFT, THIS IS THE SHERIFF'S EMPLOYMENT COSTS, AND THEY DROPPED DRAMATICALLY FROM 6.5 MILLION TO 2.4 MILLION. ALMOST 60 PERCENT. THE CHART ON THE RIGHT, THE AUTO IS THE SAME. THERE'S BEEN A DRAMATIC DECREASE IN THE AUTO LIABILITY. SHERIFFS DRIVE A LOT OF MILES. AND THEY DID A VERY GOOD JOB LAST YEAR IN BOTH OF THESE AREAS. HEALTH SERVICES IS THE SECOND MOST COSTLY DEPARTMENT THIS YEAR. AND MEDICAL MALPRACTICE, IT'S NO SURPRISE, IS THE HIGHEST COSTING AREA FOR THEM. EMPLOYMENT IS STABLE AND TO THE RIGHT IS THE CASE I MENTIONED WITH THE PEREZ CASE EARLIER WITH THE VEHICLE ROLLED OVER AND MR. PEREZ LOST FOUR FINGERS ON HIS DOMINANT HAND. THAT'S CREATED THE SPIKE THERE. THAT'S AN OUTLIER MORE LIKELY THAN NOT AND THAT'S WHY IT'S SEPARATED THERE. THE MEDICAL MALPRACTICE IS BROKEN INTO THESE FACILITIES. AND THE TWO FACILITIES THAT HAVE THE MOST ARE LAC+USC AND HARBOR U.C.L.A. LAC+USC, THE CASES THERE WERE THE WELCH CASE THAT WAS THE 7.5 MILLION. THIS INCLUDES ATTORNEYS' FEES AND COSTS. AND THAT WAS THE WOMAN WHO HAD THE RUPTURED UTERUS. WORKS WAS ALSO, WE'VE ALREADY DISCUSSED THAT CASE. THAT'S THE LABOR AND DELIVERY CASE WITH THE TWINS. HARBOR-U.C.L.A. IT WENT UP ABOUT 400,000. FERNANDEZ IS ONE OF THE CASES AND THAT WAS A HAND CASE WHERE AN INDIVIDUAL HAD THE WRONG SPLINT AND WE SETTLED THAT CASE FOR 200,000. GRADDY WAS A SURGERY CASE WHERE IT WAS KNEE SURGERY. AND AN ARTERY WAS KNICKED. AND UNFORTUNATELY MR. GRADDY DIED AND WE SETTLED THAT CASE FOR $100,000. PUBLIC WORKS IS OUR NEXT DEPARTMENT, OUR THIRD AND YOU CAN SEE THE MAIN DRIVER THERE IS GENERAL LIABILITY, THAT INCLUDES CASES LIKE ROAD CASES AND SLIP AND FALLS. AND THERE HAS BEEN AN INCREASING REDUCTION IN THOSE COSTS. EMPLOYMENT IS UP SLIGHTLY. AND THE GROUND WATER ADJUDICATION IS PAID BY A SPECIAL DISTRICT BUT THAT'S DOWN BY ALMOST A MILLION DOLLARS. PUBLIC WORK DEPARTMENT'S DOWNWARD TREND. YOU CAN SEE THE ROADWAY CASES WAS THE BIG DRIVER TWO YEARS AGO UP AT THE TOP ON THE RIGHT. AND THAT WAS 9.7 MILLION. AND THE NEXT YEAR IT WAS 3.1. THIS YEAR IT'S 2.3. SO WE'RE GOING IN THE RIGHT DIRECTION HERE. THIS IS A DOWNWARD TREND. THE TRIP AND FALL CASES GOING THE SAME WAY, 4.5 MILLION, '11/'12. LAST YEAR 550. THIS YEAR 407. THE FIRE DEPARTMENT, THEIR TROUBLE AREAS ARE EMPLOYMENT AND MEDICAL MALPRACTICE. ONE HOT SPOT IS EMPLOYMENT. AND THE MOST SERIOUS AREA THERE, WHICH COMPRISES 75 PERCENT OF THEIR EMPLOYMENT EXPENSES, IS IN RACE DISCRIMINATION AND RETALIATION CASES. THE OTHER AREA OF CONCERN IS MEDICAL MALPRACTICE AND THAT WAS LARGELY DRIVEN BY GUTIERREZ. THAT WAS THE YOUNG THREE-YEAR-OLD GIRL WHO WAS NOT TRANSPORTED TO THE HOSPITAL AFTER HAVING A BRAIN BLEED. CHILDREN AND FAMILY SERVICES, THEIR PRIMARY DRIVERS ARE GENERAL LIABILITY AND MAINLY REMOVAL OF CHILDREN FROM PARENTAL HOMES AND ALLEGATIONS OF NOT PROTECTING FOSTER CHILDREN. AND OF THE $3 MILLION IN GENERAL LIABILITY, 2 MILLION OF IT INVOLVED JUST TWO AREAS: REMOVAL, AS I SAID, OF CHILDREN FROM PARENTAL HOMES, AND FAILURE TO PROTECT. THE ARCE CASE IS A REMOVAL WITHOUT A WARRANT, AND THAT'S WHERE THE EXPENSES LIE. AND THIS YEAR WAS NO DIFFERENT. BUT ON THE ARCE CASE, THE CHILDREN WERE TAKEN FOR ONE WEEK WITHOUT A WARRANT. MCCLENDON WAS A CASE INVOLVING FOSTER, THREE FOSTER CHILDREN. AND ALLEGATION OF SEXUAL ABUSE. NOW, OVERALL, ACROSS THE COUNTY, NOT JUST MOVING AWAY FROM THE INDIVIDUAL DEPARTMENTS NOW, WE'VE HAD A DOWNWARD TREND OF EXPENSES COUNTY-WIDE IN EMPLOYMENT EXPENSES. THEY DROPPED FROM THREE YEARS AGO WHEN THEY WERE 28 MILLION. NOW THIS IS ACROSS THE COUNTY. THEY'VE NOW DROPPED TO $15 MILLION THIS YEAR. AND THIS SUCCESS CAN BE ATTRIBUTED TO THE DEPARTMENTS WHO HAVE TAKEN SPECIAL NOTE OF ALL THEIR EMPLOYMENT ISSUES AND ARE DEALING WITH THEM FAIRLY AND AGGRESSIVELY. COUNTY COUNSEL IS INVOLVED EARLY ON IN THE CASES. AND WORKING WITH THE DEPARTMENTS AND THE EQUITY OVERSIGHT PANEL ALSO CATCHING PROBLEMS EARLY AND MAKING SURE THAT THESE ARE TAKEN CARE OF. SO WITH THANKS AND SUPPORT OF THOSE VARIOUS DEPARTMENTS AND ORGANIZATIONS, THEY'VE ACHIEVED THIS RESULT. NOW, I'VE TALKED ABOUT HOW MUCH WE'VE SPENT AND JUST ONE ON CLOSING, JUST A FEW REMARKS ABOUT A CASE WHERE WE ACTUALLY NOT DIDN'T SPEND MONEY BUT WE'RE HOPEFULLY GOING TO GET MONEY, AND THAT'S IN THE COUNTY OF SANTA CLARA ATLANTIC RICHFIELD CASE. THAT WAS A CASE OF ABATEMENT BROUGHT BY 10 CITIES AND COUNTIES AGAINST MANUFACTURERS OF LEAD PAINT, AGAINST FIVE OF THEM. LOS ANGELES COUNTY WAS ONE OF THOSE 10. AND THE RESULTS, THERE WAS AN AWARD OF $1.15 BILLION LAST YEAR. AND BECAUSE LOS ANGELES COUNTY HAS ABOUT 55 PERCENT OF THE RESIDENTIAL AREAS INVOLVING WHERE THE PAINT WAS APPLIED, THEY'LL BE ABLE -- WE WILL BE ABLE TO APPLY FOR GRANTS THROUGH THE STATE IF THE JUDGMENT IS UPHELD. WE EXPECT IT TO GO PROBABLY ALL THE WAY TO THE U.S. SUPREME COURT. IT WILL TAKE SEVERAL YEARS. BUT IF WE PREVAIL, AND HOPEFULLY WE WILL, OUR SHARE WILL BE ABLE TO APPLY FOR GRANTS TO REMEDIATE AND TO EDUCATE AND HOPEFULLY TO HELP CHILDREN. AND WE'LL BE ABLE TO DO THAT TO THE TUNE OF $632.5 MILLION. THANK YOU. IF YOU HAVE ANY QUESTIONS. 

SUP. ANTONOVICH, MAYOR: WHAT ARE THE TYPES OF ALTERNATIVES THAT CURRENTLY EXIST FOR THE CASH PAY SYSTEM THAT WE CURRENTLY USE? 

STEVEN ESTABROOK: I'M SORRY. 

SUP. ANTONOVICH, MAYOR: WHAT TYPES OF ALTERNATIVES EXIST TO THE CASH PAY SYSTEM? 

STEVEN ESTABROOK: THE CASH PAY? YOU MEAN PAYMENT OF SETTLEMENTS? 

SUP. ANTONOVICH, MAYOR: YES. 

STEVEN ESTABROOK: WELL, THERE'S ONE ALTERNATIVE THAT WE ARE LOOKING AT VERY CLOSELY NOW IS THE SPREADING THOSE PAYMENTS OUT RATHER THAN PAYING THEM IN THE YEAR OF THE SETTLEMENT. AND WE HAVE TWO MECHANISMS TO DO THAT. ONE IS A CODE SECTION THAT ALLOWS US TO PAY A CERTAIN AMOUNT UP FRONT AND THEN SPREAD IT OUT, AS I SAID, OVER A PERIOD OF TIME DEPENDING UPON WHAT THE JUDGE DECIDES. ANOTHER IS IN THE MEDICAL MALPRACTICE AREA. THEY ALSO HAVE A MECHANISM TO SPREAD THAT OUT. 

SUP. ANTONOVICH, MAYOR: BECAUSE EVERY DOLLAR THAT WE SPEND, IF WE COULD DO IT OVER A PERIOD OF TIME, IT WOULD TAKE AWAY FROM CHILDREN SERVICES, PUBLIC SAFETY, OTHER VITAL AREAS. SO IT WOULD SEEM TO ME A FAIR WAY OF THE BOARD DOING OUR RESPONSIBLE LEADERSHIP BUT ALSO INSURING THAT ALL OF OUR VARIOUS DEPARTMENTS ARE NOT GOING TO BE IMPACTED SEVERELY BECAUSE OF A SEVERE JUDGMENT THAT COULD OCCUR IN ONE YEAR. 

STEVEN ESTABROOK: AND WE'VE ALSO ENGAGED IN NEGOTIATIONS AND WHEN WE SETTLE A CASE, IF THE PLAINTIFFS ARE WILLING, WELL SPREAD OUT PAYMENTS. AND THERE ARE SEVERAL CASES WHERE ONE SETTLEMENT RECENTLY WAS FOR 900,000 AND WE'RE PAYING 300,000 OVER THE SPAN OF THREE YEARS. SO WE'RE EXPLORING THOSE MECHANISMS, BOTH THOSE WHERE WE'RE ACTUALLY ENTITLED TO AND ALSO THAT WE CAN OBTAIN AGREEMENT FROM THE OTHER SIDE. 

SUP. ANTONOVICH, MAYOR: THANK YOU. 

SUP. KNABE: MR. MAYOR? 

SUP. ANTONOVICH, MAYOR: SUPERVISOR KUEHL AND KNABE, AND SUPERVISOR SOLIS. 

SUP. KUEHL: THANK YOU, MR. MAYOR. I GUESS WITH ALL DUE RESPECT AND APOLOGIES, I'M GOING EXACTLY IN THE OTHER DIRECTION. IT MAY BE THAT THE COUNTY IS PAYING OUT MONEY THAT WE CAN USE FOR OTHER THINGS, BUT THIS IS NOT THE FAULT OF THE PLAINTIFFS. THE COUNTY EITHER SETTLED OR WAS ADJUDICATED INTO SOME KIND OF DAMAGES BECAUSE OF SOMETHING THE COUNTY DID WRONG. SO I GUESS MY QUESTION IN TERMS OF RISK MANAGEMENT AND ALSO THESE VARIOUS LITIGATION AWARDS WOULD BE THREE FOLD. FIRST OF ALL, WHEN WE RECEIVE INCIDENT REPORTS, IT SEEMS TO ME SOMETIMES THESE INCIDENTS LOOK LIKE THEY'RE REPETITIOUS IN AN AREA OR IN A MATTER OR IN SOME KIND OF PROCEDURE. AND IT SEEMS TO ME SOME OF THE DEPARTMENTS WHOSE LITIGATION COSTS AND AWARDS HAVE GONE DOWN HAVE TAKEN SERIOUSLY PUTTING PROCEDURES INTO EFFECT THAT LOWER OUR RISK. PUBLIC WORKS, FOR INSTANCE, APPEARS TO HAVE TAKEN SOME STEPS. I DON'T THINK THE DIMINUTIONS IN AWARD HAPPEN SORT OF BY ACCIDENT. SO LET ME GET ALL MY QUESTIONS OUT AND MAYBE WE COULD HAVE A DISCUSSION. WOULDN'T IT BE EFFICACIOUS TO LOOK AT THESE INCIDENTS AND ANALYZING THEM FOR REPETITION TO SEE IF THERE MIGHT BE A CORRECTIVE ACTION PLAN THAT COULD BE PUT INTO EFFECT BEFORE WE'RE SUED? SOMETHING THAT WOULD DIMINISH OUR EXPOSURE. SECONDLY, IT SEEMS THAT MOSTLY WE WAIT UNTIL WE'RE SUED. AND THEN WE'RE SUED, THE POSSIBILITY OF OUR EITHER WRONGDOING OR ABILITY TO IMPROVE IS POINTED OUT IN A MORE DEFINITIVE WAY. AND PEOPLE THEN LOOK AT WHAT THEY COULD PUT TOGETHER AS A CORRECTIVE ACTION PLAN BECAUSE IT'S EITHER OFFERED AS A PART OF SETTLEMENT OR REQUIRED BY THE COURT AS AN ASPECT OF SETTLEMENT IN ADDITION TO THE MONEY. AND IT SEEMS TO ME THAT SEVERAL OF THE AWARDS, EVEN THOUGH THE CASH PAYOUT TO PLAINTIFF HAS BEEN APPROVED, ARE FORCED TO WAIT UNTIL THE COMPLETION OF A CORRECTIVE ACTION PLAN BEFORE THE PLAINTIFF IS PAID. THIS SEEMS TO ME NOT TO BE, I'LL JUST USE A FOUR-YEAR-OLD WORD, FAIR. IT DOESN'T SEEM TO BE FAIR. WE APPROVED THE SETTLEMENT TO THE PLAINTIFF. THE PLAINTIFF OUGHT TO RECEIVE PAYMENT. I WAS INTERESTED IN THE SLIDE THAT SHOWED VERY LITTLE OF IT HADN'T BEEN PAID. BUT I DIDN'T KNOW WHETHER THOSE WERE IN CASES ABOVE A MILLION DOLLARS OR OVERALL. 

STEVEN ESTABROOK: THAT'S ALL IN. 

SUP. KUEHL: BECAUSE MY IMPRESSION WAS THESE CHECKS WERE NOT GETTING OUT THE DOOR UNTIL WE HAD A CORRECTIVE ACTION PLAN. AND TAKING A LOOK AT A FEW OF THOSE CASES, CORRECTIVE ACTION PLANS DRAG ON AND DRAG ON AND DRAG ON. THAT'S NOT PUNISHING THE DEPARTMENT; THAT'S PUNISHING THE PLAINTIFF. SO THE QUESTION WITH THE EFFICACY WITH WHICH WE'RE MAKING THOSE PAYMENTS AND WHETHER YOU THINK THAT -- I MEAN, I KNOW IT SAVES US MONEY AND WE GET TO HANG ON TO IT. BUT WE'RE HANGING ON TO IT WAITING FOR A DEPARTMENT TO CREATE A CORRECTIVE ACTION PLAN THAT HAS NO INCENTIVE TO DO SO. WHAT'S THE PUNISHMENT? 

STEVEN ESTABROOK: I THINK THAT MOST OF THE DEPARTMENTS -- YEAH, MR. ROBLESS MAV SOME ADDITIONAL COMMENTS ON THIS, AS WELL. BUT FROM MY PERSPECTIVE, ONCE A CASE IS SETTLED, THE CONNECTION BETWEEN THE CAP OR THE CORRECTIVE ACTION PLAN -- AND THESE ARE PREPARED IN NEARLY EVERY CASE WHEN WE SETTLE A CASE, A CORRECTIVE ACTION PLAN IS PREPARED. SO WE'RE DOING AS YOU SUGGESTED AT THIS STAGE. AND IT'S BEEN GOING ON NOW FOR PROBABLY FIVE OR SIX YEARS THAT IN ORDER TO SETTLE A CASE, A CORRECTIVE ACTION PLAN IS ANALYZED. THE DEPARTMENT LOOKS AT IT. DECIDES HOW THEY CAN KEEP THAT FROM HAPPENING AGAIN. PREPARES A PLAN. SUBMITS A PLAN AS SUBMITTED TO THE BOARD. SO WHETHER IT'S -- AND PARTICULARLY IN CASES OVER 100,000, THERE'S A CORRECTIVE ACTION PLAN. SO THAT IS HAPPENING. AND THAT'S HOPEFULLY ONE OF THE REASONS WHY THE COSTS ARE GOING DOWN. THE ISSUE ABOUT THE DELAY AS THAT'S HAPPENING IS ANOTHER ISSUE. AND YOU HAVE A LEGITIMATE CONCERN THERE. AND THE DELAY IS WHEN THESE CASES ARE SETTLED, THE CORRECTIVE ACTION PLAN IS BEING PREPARED AND IT'S JUST THE LENGTH OF TIME THAT IT TAKES TO PREPARE IT. AND THAT CAUSES A DELAY. AND THE PLAINTIFF DOES NOT GET THEIR MONEY UNTIL THAT'S TAKEN CARE OF. THERE IS A LINK BETWEEN THE SETTLEMENT AND THE PREPARATION OF THE CAP AND THE PAYMENT OF THE SETTLEMENT MONEY. AND THEREIN IS THE ISSUE. SHOULD THERE BE A LINK? THAT LINK COSTS US MONEY, AS WELL, BECAUSE IT DOESN'T JUST SAVE US MONEY; WE HAVE TO PAY OUR ATTORNEYS TO GO BACK DOWN TO THE COURT TO ASK FOR MORE TIME BECAUSE THE JUDGES PUSH ON THESE SETTLEMENTS. THEY WANT THEM OFF THEIR DOCKET. SO THAT COSTS US MONEY AS WELL AS ON THE DELAY WE SAVE MONEY ON THAT END BUT COST US MONEY ON THE OTHER. SO WE HAVE TO DECIDE IF WE WANT TO KEEP THOSE LINKED. AND THAT'S THE ISSUE THERE. 

SUP. KUEHL: WELL, AS YOU CAN TELL FROM MY QUESTION, I DON'T FAVOR KEEPING THAT LINK. THAT WOULD BE A DISCUSSION, OF COURSE, AMONG ALL OF US TO TAKE PLACE IN THE FUTURE. BUT IT WAS INTERESTING TO ME THAT YOU SAID THAT THE COUNTY MAY ALSO SUFFER SOME LOSS BECAUSE OF THE LINK BECAUSE OF IT CARRYING ON, CARRYING ON, CARRYING ON, WE HAVEN'T PAID THE PLAINTIFF, WE HAVEN'T PAID OUT A SETTLEMENT WHICH WAS AGREED TO. WE HAVE TO KEEP GOING BACK INTO COURT AND ALSO THERE'S NO TIME LIMIT ON OUR DEPARTMENT PRESENTING A CORRECTIVE ACTION PLAN FOR THE MOST PART, OR IS THERE? 

STEVE ROBLES: STEVE ROBLES, COUNTY RISK MANAGEMENT. THERE REALLY IS NOT A CONCRETE TIME FRAME BETWEEN WHEN THE SETTLEMENT OCCURS TO WHEN THE CORRECTIVE ACTION PLAN -- WE WANT TO GET THE CORRECTIVE ACTION PLAN, WHEN IT'S READY TO COME TO THE CLAIMS BOARD, TO THE BOARD. YOU HAD MENTIONED THE INCIDENTS. THE DEPARTMENTS DO PUT IN REMEDIAL ACTIONS WHEN SOMETHING OCCURS AND WHEN THEY KNOW ABOUT IT. A LOT OF TIMES WE DO GET CLAIMS IN BEFORE WE'RE EVEN SUED, WE MAKE CONTACT WITH DEPARTMENTS. AND THOSE DEPARTMENTS HAVE MADE SOME SORT OF REMEDIAL CORRECTION OF WHATEVER THE INCIDENT PARTICULARLY WAS. IF THAT DEVELOPS INTO A LAWSUIT DOWN THE ROAD OR A CLAIM THAT REQUIRES A CORRECTIVE ACTION PLAN, THOSE REMEDIAL ACTIONS THEN BECOME PART OF THE CORRECTIVE ACTION PLAN. THAT'S THE FORMALIZATION OF ALL THE CORRECTIVE ACTIONS THAT WERE TAKEN PLACE. SO IT'S NOT THAT THE COUNTY IS NOT DOING THESE CORRECTIVE ACTIONS. WHEN THEY KNOW ABOUT THEM, THERE'S FOLLOW UP MECHANISMS THAT RISK MANAGEMENT TAKES, OUR INSPECTOR GENERAL TAKES TO DO THAT. AND IN SOME INSTANCES REGARDING THE CORRECTIVE ACTION PLANS THAT DO TAKE TIME, WE HAVE SEPARATED THEM OCCASIONALLY. RISK MANAGEMENT INSPECTOR GENERAL HAS TO LOOK AT THE SUMMARY CORRECTIVE ACTION PLAN, APPROVE THOSE. AND THEY HAVE SEPARATED THEM WHEN THERE'S JUST DETAILS REGARDING THE CASE THAT CANNOT BE FIXED JUST YET. AND THERE COULD BE A NUMBER OF OUTSIDE INFLUENCES THAT REQUIRE THAT. AND FOR THOSE INSTANCES, WE SEPARATED THEM MOVING FORWARD. BUT FOR THE CORRECTIVE ACTION PLANS ON ALL THOSE OTHER CASES, IT'S THE FINALIZATION FOR THE DEPARTMENT THAT ALL OF WHAT YOU SAID SHOULD HAVE BEEN DONE IS DONE AND WHAT YOU ARE GOING TO DO IN THE FUTURE HAS ADDRESSED THOSE CORRECTIVE ACTIONS THAT WE NEED TO HAVE HAPPEN TO PREVENT THE CLAIMS OR LAWSUITS THAT ARE HAPPENING IN THE FUTURE. 

SUP. KUEHL: WELL, I THINK FOR MY PART IN THE FUTURE, I WANT TO EXPLORE DE-LINKING THESE THINGS BECAUSE WE'RE PUNISHING PLAINTIFFS. BUT IT'S NOT HELPING OUR DEPARTMENTS. WE ALREADY ADJUDICATED THIS OR SETTLED IT. WE GOT A FULL REPORT FROM COUNTY COUNSEL, ET CETERA. THESE ARE DAMAGES WHICH ARE OWED. AND IN TERMS OF THE CORRECTIVE ACTION PLANS, PERHAPS OR PERHAPS FOR BOTH, PERHAPS A TIME LIMIT MIGHT MAKE SENSE. I'M NOT ASKING BECAUSE OBVIOUSLY YOU COULDN'T SAY YES YOU DON'T KNOW WHAT THAT IS. BUT JUST FROM MY THINKING, IT SEEMS TO ME THAT IN THE FUTURE, I WOULD PROBABLY COME BACK WITH SOME REQUESTS ABOUT A DE-LINK. THANK YOU, GENTLEMEN. THANK YOU, MR. MAYOR. 

SUP. KNABE: YEAH, I HAD THE SAME CONCERNS ABOUT THE CORRECTIVE ACTIONS AND YOU'VE ANSWERED THAT AND YOU'RE COMING BACK IN A DIFFERENT WAY. BUT THE ONE THING I NOTICED: WHAT KIND OF AN EXAMPLE, PUBLIC HEALTH, WHY WOULD THEIR LEGAL FEES ALL OF A SUDDEN SKYROCKET? I MEAN IT WAS AN UNUSUAL JUMP. MOST OF THE DEPARTMENTS YOU UNDERSTAND, BUT THE PUBLIC HEALTH PIECE WAS NOTICEABLE IN THE SENSE THAT THAT'S USUALLY NOT A TRIGGER KIND OF A THING. 

STEVEN ESTABROOK: TWO CASES, SUPERVISOR. ONE IS THE MICHAEL WEINSTEIN CASES WHICH COST THAT DEPARTMENT QUITE A BIT OF MONEY. I DON'T HAVE IT AT THE TIP OF MY TONGUE BUT IT'S QUITE A BIT OF MONEY. AND ALSO THE LEAD-BASED PAINT CASE ALSO COST. WE HAD SEVERAL PEOPLE WORKING ON THAT. AND THE CHARGES THERE. THOSE TWO CASES. BUT PRIMARILY THE AIDS, MICHAEL WEINSTEIN CASE. AND THERE'S FOUR OF THOSE CASES, NOT JUST ONE. 

SUP. KNABE: AND THAT ALSO PROBABLY WAS THE PIECE AT L.A. CITY, THEN, IS THAT CORRECT? 

STEVEN ESTABROOK: I'M SORRY? 

SUP. KNABE: THE FIGHT WE GOT IN, NOT FIGHT, BUT TRYING TO PROTECT L.A. CITY FROM HAVING THEIR OWN PUBLIC HEALTH DEPARTMENT, I ASSUME THE BREAKDOWN? 

SPEAKER: YES. 

SUP. KNABE: THANK YOU. 

SUP. SOLIS: THANK YOU FOR YOUR PRESENTATION AND JUST A COUPLE OF THINGS ON PUBLIC WORKS. I WAS REALLY HAPPY TO SEE THAT THERE'S BEEN A DECLINE IN ROADSIDE ACCIDENTS, THOUGH I CONTRIBUTE THAT TO SAFETY AND ALL OF THOSE REGULATIONS THAT THEY'RE PROBABLY FOLLOWING AND ENFORCING AND PROVIDING THAT TRAINING, WHICH IS SOMETHING TO BE SAID ABOUT THEM BECAUSE IT'S VERY DANGEROUS TO HAVE PEOPLE ON THE ROAD AND ALSO PEDESTRIANS THAT ARE CROSSING WHERE THERE ARE REPAIRS GOING ON. BUT ALSO TO EMPHASIZE HOW IMPORTANT IT IS FOR THAT INFORMATION ALSO TO BE SHARED. MAYBE THERE ARE SHORTCUTS THAT THEY HAVE, A MANUAL THAT COULD BE SHARED OR EVEN OUR CONTRACTORS OUTSIDE OF JUST PUBLIC WORKS AND HEALTH, HOW THAT IS REINFORCED. I THINK THAT CAN ALSO SAVE US A LOT OF MONEY AS A SIDE NOTE. BUT I WANT TO COMMEND PUBLIC WORKS FOR THAT. THE OTHER THREE AREAS THAT I THINK THAT I'M CONCERNED ABOUT IS DISCRIMINATION WITH RESPECT TO THE FIREFIGHTERS AND THE REMEDIES THERE. AND I UNDERSTAND THAT'S A WORK IN PROGRESS. BUT CERTAINLY HAVING SOME TIME TABLES THERE, ALSO. PREVENTION, TRAINING AND MONITORING OBVIOUSLY HELPS. IT'S NOT A NEW ISSUE, BUT IT IS ONE THAT IS OF CONCERN TO MANY OF US. AND PROBABLY ONCE THOSE MANUALS ARE PUT TOGETHER APPROPRIATELY AND TRAINING, THAT CAN ALSO BE USED IN OTHER DEPARTMENTS. BECAUSE WE ALSO HEARD THERE ARE SOME CONCERNS WITH RESPECT TO OTHER EMPLOYMENT AREAS. THAT CAUSED ME SOME DISTRESS. AND THEN OF COURSE EVALUATION. I'M JUST WONDERING WHAT TYPE OF EVALUATION HAS BEEN DONE FOR CONTRACTING OUTSIDE COUNSEL? IF THAT HAS ACTUALLY GONE UP WHILE OUR COUNTY COUNSEL'S COSTS HAVE GONE DOWN. SO WHAT IS SO UNIQUE OR WHAT IS CHANGING THERE IN THE LITIGATION FIELD? OR IS IT A SYMPTOM OF SOMETHING ELSE? MAYBE WE HAVE FOLKS THAT HAVE BEEN WITH US FOR A LONG TIME AND LAWS HAVE CHANGED, THINGS HAVE CHANGED, DYNAMICS HAVE CHANGED, AND I UNDERSTAND THAT; BUT HOW CAN WE BETTER BE GUARDIANS OF OUR PURSE STRINGS? I THINK THAT'S A VERY IMPORTANT ISSUE, AS WELL, FOR THE TAXPAYERS TO BE AWARE OF. AND THEN LASTLY I KNOW WITH RESPECT TO USE OF FORCE IN THE SHERIFF'S DEPARTMENT, THAT'S SOMETHING WE ALL ARE VERY CONCERNED ABOUT. AND THE MORE TRAINING AND MORE TOOLS THAT WE HAVE AT HAND, I HOPE WILL BEGIN TO REDUCE THOSE CASES AND HOPEFULLY PROVIDE PREVENTION. SO I THINK OVERALL IT SOUNDS LIKE WE'RE GOING IN THE RIGHT DIRECTION. BUT OBVIOUSLY WE NEED TO DO MORE. AND SOME OF US WHO ARE JUST, AS ONE OF MY COLLEAGUES SAYS REPEATEDLY, THAT WE'VE BEEN HERE FIVE MINUTES AND THERE'S SO MUCH COMING OUR WAY. BUT THAT DOESN'T MEAN THAT WE DON'T CARE AND SHARE EQUALLY WITH ALL OF YOU WHERE WE SHOULD GO. SO I JUST WANT YOU TO KNOW THAT FROM THIS SUPERVISOR'S PERSPECTIVE THAT WE WANT TO WORK WITH YOU AND ALSO SEE THAT WE MEET SOME ACHIEVABLE GOALS THAT WE CAN PROUDLY REPORT BACK TO THE PUBLIC. 

STEVE ROBLES: OKAY. I GOT THE RISK MANAGEMENT REPORT. I'M STEVE ROBLES. I HAVE A BRIEF REPORT FOR YOU. WE WILL FOCUS ON THE COUNTY'S OVERALL TOTAL COST OF RISK AS WELL AS WORKER'S COMPENSATION LOSSES, LIABILITY TRENDS, NOT THE DOLLARS WE DISCUSSED EARLIER AND THE VARIOUS PREVENTION ACTIVITIES THAT ARE BEING COMPLETED WITHIN THE C.E.O.'S OFFICE AS WELL AS WITHIN OUR DEPARTMENTS. THE MEASUREMENT OF ALL OF OUR LOSSES, WORKERS COMPENSATION AND GENERAL LIABILITY IS OUR TOTAL COST OF RISK. IT IS THE COST OF ALL THESE PAID DIVIDED BY OUR COUNTY'S OPERATING BUDGET. IT'S IMPORTANT FOR US BECAUSE AS WE EITHER EXPAND OR CONTRACT OUR OPERATING BUDGET, IT GIVES US A GUIDE TO WHERE WE ARE AS IT RELATES TO OVERALL LOSS GIVEN OUR EXPOSURES. OUR TOTAL COSTS OF RISK HAS BEEN DECLINING FOR THREE YEARS NOW. AND WE HAVE DECLINED 3.2 PERCENT. AND OUR OVERALL COST OF RISK FOR L.A. COUNTY IS CURRENTLY AT 2.1 PERCENT. 70 PERCENT OF OUR ANNUAL TOTAL COST OF RISK CAN BE ATTRIBUTED TO OUR WORKER'S COMPENSATION COSTS. ONE REASON WHY OUR TOTAL COSTS OF RISK IS TRENDING DOWN IS BECAUSE OUR WORKER'S COMPENSATION PROGRAM HAS BEEN AND CONTINUES TO BE STABLE THROUGHOUT THE YEARS. AND IN SOME INSTANCES, SEVERAL CATEGORIES WITHIN OUR WORKER'S COMP SYSTEM IS TRENDING DOWN. TO ILLUSTRATE THIS, OUR WORKER'S COMP FREQUENCY, THE NUMBER OF CLAIMS THAT WE HAD WENT UP ABOUT 1 PERCENT LAST YEAR WHILE THE COSTS OF ALL CLAIMS THAT WE'VE HAD THAT WE CONTINUE TO PAY ON IN THE HISTORY OF OUR CLAIMS HAS DECLINED APPROXIMATELY 1 PERCENT. THIS IS DUE TO SEVERAL FACTORS THAT WE PUT TOGETHER IN COST CONTAINMENT AND TRIED TO CLOSE CLAIMS OUT SO WE DON'T CONTINUE TO PAY ON THEM. DEPARTMENTS ALSO AND THE C.E.O. RISK MANAGEMENT HAS ALSO BEEN WORKING FOR SEVERAL YEARS ON A ROBUST DISABILITY MANAGEMENT PROGRAM TO BRING PEOPLE BACK TO WORK SO WE'RE NOT PAYING INTO THE WORKER'S COMP SYSTEM. I'M NOT GOING TO GO INTO MUCH ABOUT THE LIABILITY COSTS BECAUSE MR. ESTABROOK HAS TALKED A BUNCH ABOUT THAT. I WANT TO TALK BRIEFLY, THOUGH, ABOUT THE TRENDS. OVER THE LAST THREE YEARS, WE HAVE SEEN IN THE NUMBER OF CLAIMS, THE CONTINUED DOWNWARD TREND OF OUR EMPLOYMENT LIABILITY CLAIMS. SO NOT ONLY ARE WE HAVING LOWER COSTS, WE'RE ALSO HAVING THE LOWER NUMBERS OCCUR. IN OUR VEHICLE LIABILITY, MEDICAL MALPRACTICE LIABILITY AND GENERAL LIABILITY, THOSE NUMBER OF CLAIMS AND LAWSUITS THAT WE'RE GETTING ARE FLAT. SO THEY'RE KIND OF ESCALATING UP AND DOWN A LITTLE BIT, BUT OVERALL THREE YEARS ARE FLAT. AND LAW ENFORCEMENT LIABILITY, WE HAVE A THREE-YEAR INCREASING TREND. SO THAT IS CERTAINLY SOMETHING BOTH WITH THE DOLLARS AND AS THE NUMBERS THAT WE WANT TO MAKE SURE THAT WE'RE LOOKING AT. SOME OF THE PREVENTION ACTIVITIES THAT WE DO WITHIN THE COUNTY AS WELL AS WITH C.E.O. RISK MANAGEMENT IS WE TRAIN THOUSANDS OF MANAGERS, SUPERVISORS AND COORDINATORS ON PREVENTION ACTIVITIES COVERING A WIDE RANGE OF GENERAL LIABILITY TOPICS. RISK MANAGEMENT ATTENDS HUNDREDS OF CLAIM REVIEWS WITH DEPARTMENTS AND THIRD-PARTY ADMINISTRATORS TO ENSURE CLAIM HANDLING AND TO START THE CORRECTIVE ACTION PROCESS. AND A RISK MANAGEMENT INSPECTOR GENERAL PROVIDES CORRECTIVE ACTION PLAN SUPPORT TO THE BOARD OFFICES AS WELL AS DEPARTMENTS WHEN THEY'RE TRYING TO PUT TOGETHER THESE PLANS TO FINALIZE. FINALLY, WE PUBLISH THE INTEGRATED SERVICE PLAN FOR DEPARTMENTS, WHICH IS A SNAPSHOT OF DEPARTMENT KEY PERFORMANCE INDICATORS THAT SUPPLEMENTS THE ENTERPRISE RISK MANAGEMENT DASHBOARD. THAT SUMS UP BRIEFLY FROM THE TRENDS AND THE RISK MANAGEMENT STANDPOINT WHAT WE'RE DOING ABOUT THE LOSSES THAT WE HAVE, WHAT WE'RE DOING ABOUT WORKER'S COMPENSATION. SO THAT IS MY REPORT. QUESTIONS? 

SUP. KNABE: YOU KNOW, YOU INDICATED THE TRENDS, SOME ARE FLAT. YOU SAID LAW ENFORCEMENT TREND UP. HOW FAR BACK DO THOSE CASES GO? THEY'RE NOT CURRENT, RIGHT? WHEN WE SPEAK IN TERMS OF RISK MANAGEMENT, IT COULD BE A CASE -- SO HOW FAR BACK ON THAT TRENDING UP WOULD YOU SAY THOSE CASES ARE GOING? 

STEVE ROBLES: WE'RE TRENDING THE MOST RECENT THREE YEARS. SO IN LAW ENFORCEMENT LIABILITY, THAT THREE-YEAR TREND IS UP. GOING THREE YEARS. 

SUP. KNABE: CURRENT. 

STEVE ROBLES: CURRENT. THAT'S CORRECT. OKAY, THANK YOU. 

GENEVIEVE CLAVREUL: GENEVIEVE CLAVREUL, GOOD AFTERNOON AGAIN. WELL, I WAS KIND OF IMPRESSED TO HEAR THE WORD "FAIR" SPOKEN OUT BY SUPERVISOR KUEHL. BECAUSE LAST YEAR, MANY TIMES THERE WERE SOME COURT CASES WERE WIN AGAINST THE COUNTY AND, SO EITHER WERE CONTINUED WEEK AFTER WEEK AFTER WEEK AND EVERY WEEK I BROUGHT THAT ISSUE. AND ABOUT THE SEPARATION ON REPAY, LIKE TODAY THEY NEVER MENTIONED AT LEAST THREE SEXUAL HARASSMENT LAWSUITS. NOT ONLY WE LOST THOSE CASES, BUT IN ADDITION OF THAT, WE ARE FINED BECAUSE NO ARRANGEMENT HAD BEEN MADE IN THAT DEPARTMENT TO CORRECT THE POSSIBILITY OF SEXUAL HARASSMENT. AND TO HAVE ONLY ONE MINUTE TO DEAL WITH MILLIONS OF DOLLARS IS ASININE. 

ERIC PREVEN: SO SHOULD SHE TAKE ANOTHER MINUTE BECAUSE THAT WAS TWO ITEMS OR THREE ITEMS? THAT IS A STIFF ARM THERE, SIR. I WILL SAY THAT THIS IS INTERESTING NEWS. OF COURSE I'VE BEEN FOLLOWING THIS VERY CLOSELY. AND I APPRECIATE THE COMMENTS FROM THE TWO NEW SUPERVISORS. I WANT TO EMPHASIZE THAT THE ATTORNEY/CLIENT PRIVILEGE HERE IS THE BOARD OF SUPERVISORS TO WAIVE. AND WHEN WE HAVE LIGHT ON THESE LEGAL ISSUES, IT IS BECAUSE ACCORDING TO THE CASE WHICH A.C.L.U. AND PREVEN WON AND THEN HAD BEEN IN APPEAL, IT'S YOUR DECISION, ATTORNEY/CLIENT PRIVILEGE IS TO YOU TO DECIDE WHAT GETS OUT AND THAT IS IT. THOUGH IT'S NOT TRUE. WE'RE GOING TO FIGHT THAT. BUT THAT'S IT. IF THAT'S THE CASE AND IT IS YOUR JOB TO SHARE WHAT YOU CAN, THIS IS AN IMPORTANT MEETING AND SHOULDN'T BE DELAYED BEYOND SEPTEMBER, AS SUPERVISOR MOLINA HAS ASKED, IT SHOULD BE AS URGENT AS POSSIBLE. THE CITY IS DOING GOOD ONE SMALL THING, THEY'RE POSTING HOW MUCH THEIR LEGAL FIGHTS ARE COSTING. I CAN ONLY SAY THAT THIS TIMING IS FRUSTRATING. I WANT TO SAY ONE THING ABOUT MALPRACTICE BECAUSE MALCOLM GLADLOW WELL WROTE A BOOK CALLED "BLINK". HE DIFFERENTIATED ABOUT WHY PEOPLE SUE THEIR DOCTORS. IT'S NOT BECAUSE OF SHODDY MEDICAL CARE, SURPRISINGLY. IT IS BECAUSE OF THE TONE OF VOICE. AND I THINK THAT ROBLES AND ESTABROOK COULD REALLY TAKE THAT ON BOARD WITH DR. KATZ BECAUSE IT MAKES A HUGE DIFFERENCE. LOOK INTO THAT. 

ARNOLD SACHS: YES, THANK YOU. EVEN STARTED BEFORE. I LIKE THIS. "ROUND UP THE USUAL SUSPECTS" WITH A LINE FROM "CASABLANCA." THE SAME THREE SPEAKERS. YOU HAVE IN HERE THE LITIGATION REPORT FROM HARBOR-U.C.L.A. AND U.S.C. BUT YOU DON'T HAVE ANYTHING FROM RANCHO OR OLIVE VIEW. SO I WAS WONDERING: MAYBE THEY HAVE SUCH AN OUTSTANDING PROGRAM AT BOTH THOSE TWO HOSPITALS THAT YOU COULD IMPLEMENT THAT LITIGATION REDUCTION FOR HARBOR U.C.L.A. AND U.S.C. AND THERE WAS A PART IN HERE THAT SAID $102 MILLION AVERAGE OVER THE LAST FIVE YEARS. WHAT WOULD BE THE AVERAGE OVER THE PREVIOUS FIVE YEARS BEFORE THAT? WHEN WE HAD AT LEAST TWO SITTING SUPERVISORS SO WE COULD GET A 10-YEAR BREAKDOWN. CAMERAS, I MEAN SUPERVISOR MOLINA TOOK THAT OFF THE AGENDA. BUT YOU'RE SPENDING OVER $102 MILLION AVERAGE THESE LAST FIVE YEARS, WHAT WOULD BE THE PROJECTIONS IF YOU HAD CAMERAS ON THE FIELD OFFICERS AND HOW WOULD THAT ABATE THE LITIGATION COSTS? CHIME IN ON THE ITEM. THERE'S THREE ITEMS, COUNTY COUNSEL, CAN SOMEBODY WAKE THEM UP AND SAY WE SHOULD BE ABLE TO TALK ON EACH ITEM SEPARATELY BECAUSE [OFF MIC]. 

SUP. ANTONOVICH, MAYOR: SOLIS SECOND. WITHOUT OBJECTION, SO ORDERED. NOW PUBLIC COMMENT. LET ME CALL UP JOSE MARTINEZ, ROBERT LUCAS, WENDY VOTT. ERIC PREVEN. YES, SIR. 

ERIC PREVEN: TO GET OUT OF HERE. THANK YOU, ERIC PREVEN COUNTY RESIDENT FROM DISTRICT 3 IN THE PUBLIC COMMENT AND ALSO A CANDIDATE FOR THE C.D.2 ELECTION OR WHATEVER IT IS. SO I WAS MAKING THE POINT ABOUT MALPRACTICE. AND I'LL JUST BUTTON IT OFF BECAUSE I DON'T KNOW IF IT LANDED. IT IS A FASCINATING DETAIL. AND I KNOW THAT WE'RE ALWAYS LOOKING, AS I THINK SUPERVISOR KUEHL WAS REFERENCING THE CORRECTIVE ACTION PLANS. WE ARE LOOKING FOR THINGS THAT REALLY MAKE A DIFFERENCE. I WOULD URGE YOU TO READ THE BOOK "BLINK" AND MALCOLM GLADWELL'S ASSESSMENT. IT IS AN AMAZING PHENOMENON THAT TONE OF VOICE ACTUALLY IS A BETTER DETERMINANT THAN SHODDY MEDICAL CARE ABOUT WHO WINDS UP SUING THEIR DOCTOR OR THE HOSPITAL. IT'S VERY, VERY INTERESTING. I WOULD SAY ALSO THE ISSUE ABOUT FEES AND LEGAL FEES PAID TO CONTRACT ATTORNEYS. WE HAVE A RATE OF ABOUT 150-ISH DOLLARS. BUT WE DON'T -- WE'RE NOT REQUIRED TO PAY THAT. AND I THINK THAT THAT IS CONFUSING. IT WOULD BE INTERESTING TO KNOW WHEN WE PAY THE BIGGER $200, $300, $400 AN HOUR AND WE'RE NOT. AND I WOULD URGE THIS BOARD TO CONSIDER SOMETHING LIKE THE CITY IS DOING POSTING A BIT MORE ACCESSIBLE INFORMATION ABOUT THESE MATTERS FOR THE SAME REASON THAT WE WANT MAXIMUM TRANSPARENCY ON THESE THINGS. INSIDE THE RUBRIC OF BEING ABLE TO PROTECT PEOPLE WHO ARE EMPLOYEES FROM THEIR -- FOR DOING THE WORK THEY'RE SUPPOSED TO BE DOING. BUT WHEN THEY'RE OUT OF POLICY, THIS IS REALLY WHAT OUR LAWSUIT WAS ABOUT, WE DON'T WANT TO BE DOUBLING DOWN AND, YOU KNOW, WINNING VICTORIES IN EXCESSIVE FORCE HERE WHEN WE KNOW WHAT WAS GOING ON THERE. AND WE DID WIN SEVERAL AND WE'RE BOASTING ABOUT HOW WE WON THOSE CASES. YET NOW KNOWING WHAT WE KNOW, OBVIOUSLY THAT WAS IN FACT A PYRRHIC VICTORY. SO IN CONCLUSION, I WOULD SIMPLY SAY THAT THIS BOARD OF SUPERVISORS HAS THE CHANCE TO REDEFINE -- I KNOW THERE'S SOMETHING CALLED A SETTLEMENT AUTHORITY AND CORRECTIVE ACTION STUDIES THAT'S BEING INITIATED. AND WE SHOULD LOOK CLOSELY AT THAT. IT'S BEEN SINCE 1982 THAT WE RE-VISITED THESE MATTERS. SO I THINK IT'S REALLY TIME. AND I LOOK FORWARD TO YOUR ROLLING UP YOUR SLEEVE AND GETTING INTO IT. THANK YOU. 

SUP. ANTONOVICH, MAYOR: THANK YOU. ROBERT LUCAS. FLUSS SIGMUND. TERESIJA SIGMUND. YES, MA'AM. 

WENDY VOGT: MY NAME IS WENDY VOGT, I'M FROM THE WEST L.A. AREA. I HAVE AN OPEN D.C.F.S. CASE WHICH I HAD FROM LAST MARCH. I'M LOOKING TO GET HELP FROM MY ELECTED OFFICIALS AND MY PEOPLE. I FEEL D.C.F.S. HAS LET MY FAMILY DOWN. I HAVE A SPECIAL NEEDS CHILD. WEST SIDE REGIONAL WAS COURT ORDERED. I JUST GOT AN ASSESSMENT FROM THEM. I HAVE YET TO GET A CALL. FAMILY PRESERVATION WAS COURT ORDERED. THEY HAVE YET TO SHOW UP AT MY PLACE OF RESIDENCE. I AM NOW A SINGLE MOM STRUGGLING. I HAVE NOT RECEIVED ANY MONEY FOR MY SON, NOT ONE FOOD STAMP DOLLAR. I NEVER EVEN RECEIVED A MEDI-CAL CARD FOR MY SON. I AM JUST BLESSED THAT I HAD CARE AT WESTWOOD, U.C.L.A. AND SANTA MONICA U.C.L.A. THAT I WAS ABLE TO CONTINUE TO GET HIM CARE. THEY JUST RECENTLY SIGNED OFF ON THE DETENTION ORDER RELEASE, BUT I RECEIVED MY SON BACK MONTHS BEFORE THAT UNOFFICIALLY WHICH WAS VERY DISPLEASING TO THE D.C.F.S. ATTORNEY. I AM LOOKING FOR HELP, FOR REAL HELP. MY UNEMPLOYMENT BENEFITS HAVE RUN OUT FROM U.C.L.A. I HAVE BEEN DOING THE BEST THAT I CAN. I AM JUST -- IT HAS BEEN JUST A HORRENDOUS, DEMORALIZING EXPERIENCE WITH D.C.F.S. AND I AM ASKING, BEGGING FOR HELP. I FEEL THE SITUATION'S DEPLORABLE. AND I WOULD LIKE TO SEE IT CHANGED. 

SUP. ANTONOVICH, MAYOR: WHERE DO YOU LIVE? 

WENDY VOGT: I LIVE IN WEST L.A. 

SUP. ANTONOVICH, MAYOR: WE HAVE DEPUTY -- SUPERVISOR KUEHL'S DEPUTY WILL TALK TO YOU NOW. AND ALSO THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES WILL BE JOINED. 

WENDY VOGT: I WOULD LIKE TO SPEAK TO SOMEONE MARKING OFF THE BOX AND CONTINUING TO POCKET THE MONEY. 

SUP. ANTONOVICH, MAYOR: SUPERVISOR KUEHL WILL NOT MARK IT OFF THE BOX. 

WENDY VOGT: THANK YOU. I HAVE A SPECIAL NEEDS CHILD. I NEED RESPITE CARE. I WOULD REALLY APPRECIATE THE HELP. 

SUP. ANTONOVICH, MAYOR: LISA IS REALLY GOOD. SHE'LL TALK TO YOU. EXCUSE ME. IS JOSE MARTINEZ HERE? JOSE MARTINEZ? HE LEFT. OKAY. DAVID SERRANO. OKAY. AND ARNOLD SACHS? OKAY. YES, MA'AM. 

FLUSS SIGMUND: HELLO. I AM BRENTWOOD AND I WOULD LIKE ALL MY STUFF BACK. [INAUDIBLE] AND I WOULD LIKE TO HAVE MY STUFF BACK. AND I REALLY WOULD LIKE IT BACK. I PLAYED THIS PEE-PEE GAME AND MY MOTHER SAID THAT WAS WRONG IN FOSTER CARE. 

SUP. ANTONOVICH, MAYOR: THANK YOU. YES? 

TERESIJA SIGMOND: MY SON HAS BEEN ASKING REPEATEDLY FOR HIS STUFF BACK IN FOSTER CARE. THEIR MONEY, THEIR TOYS, THE MANY SPECIAL THINGS THAT THEY GOT FROM THE FAMILY. OUR CASE HAS BEEN CLOSED. THEY HAVE RECEIVED NONE OF THEIR THINGS. I TOLD THEM IF YOU WANT TO ASK FOR YOUR THINGS BACK THEY HAVE A RIGHT TO POSSESSIONS, COME HERE. NOT THAT THAT EVER GETS US ANYWHERE, BUT AT LEAST WE ASK. THE THINGS I WAS TALKING ABOUT, THE SEXUAL EXPLOITATION OF MY SONS IS I WAS TOLD, YOU COULD ASK HIMSELF WHAT HAPPENED. THIS MAN HE WAS LIVING WITH WHICH THERE'S NO CRIMINAL CHARGES IN PLACE. NOBODY EVER COMES TO MY DOOR ASKING WHAT HAPPENED. HE PLAYED PEE-PEE GAMES WITH MY SON AND THERE'S A LOT OF THINGS I HAVE TO TEACH MY SON THAT HE NEEDS NOT TO DO AND THAT THEY'RE WRONG THAT I HAVE BEEN COMING TO YOU EXCEPT FOR THE WOMEN YOU HAVE NOT BEEN HERE FOR TIME. I HAVE BEEN COMING HERE TELLING THAT MY CHILDREN ARE SEXUALLY EXPLOITED. THERE'S THINGS GOING ON THAT I'M FINDING OUT. AND ALL THAT STUFF I WAS DUMPED ON AND DUMPED ON AND I WAS THE TARGET BECAUSE I'M SO BAD FOR SAYING I DON'T WANT MY KIDS SEXUALLY EXPLOITED IN FOSTER CARE. AND YOU HAVE THESE PEOPLE HERE WITH THE BIG BOARDS WITH THE MONEY YOU LOSE IN LITIGATION. HOW ABOUT THE SOULS YOU LOSE? HOW ABOUT MY SON? WE HAVE TO PRAY NOT BECOME UP WITH OF THOSE PEOPLE WHO DO THOSE THINGS? WHO DOES THOSE THINGS? PEOPLE WHO EXPERIENCE THOSE THINGS. AND YOU FOR YEARS SAT THERE DO NOTHING WHEN I TOLD YOU HE'S DOING THINGS, HE'S SAYING THINGS THAT ARE WRONG. AND WHAT DID I FIND OUT FROM MY OTHER SON? THEY WERE TOLD HE NOT ACT LIKE THAT IN FRONT OF YOUR MAMA. THAT'S THE ONLY THING THAT THE D.C.F.S. DID AND THE PEOPLE HE WAS LIVING IN, MAKE SURE HE DOESN'T ACT LIKE THAT IN FRONT OF ME, HIS ONLY VOICE, HIS ONLY PERSON SAYING THIS IS WRONG. I DON'T LIKE THE FACT THAT MY CHILD WAS PLAYING PEE-PEE GAMES WITH A GROWN MAN THAT HE EXPLAINS THE SEXUALLY EXPLICIT THINGS HE SAW ON TV. THERE'S HE DOES THAT I DON'T HAVE TO GET HIM TO NOT DO THAT, I DON'T WANT TO BE SPECIFIC ABOUT. THESE ARE GOING ON WITH MANY PEOPLE THAT YOU'RE NOT HELPING. 

SUP. ANTONOVICH, MAYOR: THANK YOU. LET ME ALSO CALL UP ARNOLD SACHS AND OSCAR MOHAMMED. MR. SERRANO. 

DAVID SERRANO: GOD ALMIGHTY IS THE FATHER AND THE SON AND THE HOLY SPIRIT. THE HOLY TRINITY IS THE ONE AND ONLY GOD. THE HOLY TRINITY IS THE CREATOR OF HEAVEN AND THE UNIVERSE. REALITY IS THE LORD GOD JESUS CHRIST CREATED HEAVEN AND THE UNIVERSE, AMEN. THERE WILL BE A BLOOD MOON LUNAR ECLIPSE ON APRIL 4, 2015, A.D., AND THERE WILL BE ANOTHER BLOOD MOON LUNAR ECLIPSE ON SEPTEMBER 28TH, 2015. LIKE IT IS RECORDED IN THE HOLY BIBLE IN THE BOOK OF REVELATION IN THE HOLY INFINITE TRINITY PROPHESIED THERE WILL BE A GREAT EARTH QUAKE ON THE SOUTHERN CALIFORNIA SAN ANDREAS FAULT THAT DEVASTATES REGIONS OF LOS ANGELES COUNTY AS A BIG STORM WITH THUNDER AND LIGHTNING DARKENS THE SKY IN A YEAR THAT THE MOON WILL BE TURNED THE COLOR BLOOD RED AND THE HORIZONTAL DISPLACEMENT MOUNTAINS AND ISLANDS TO BE MOVED OUT OF PLACE. EVERYBODY KNOWS LOS ANGELES IS THE CITY OF ANGELS. ONE OF THE THINGS REVELATION 10:1-10:5 IS ABOUT HOW THE PACIFIC AND NORTH AMERICAN TECTONIC PLATES COME INTO CONTACT IN THE SAN ANDREAS FAULT IN LOS ANGELES COUNTY. THE PACIFIC PLATE IS ALMOST ENTIRELY UNDERNEATH THE PACIFIC OCEAN AND THE NORTH AMERICAN PLATE INCLUDES THE REST OF CONTINENTAL NORTH AMERICA. SOME OF THE EVENTS REVELATION 6:12 TO 6:17 PROPHESIED IS THAT THE MOON WILL BE TURNED THE COLOR BLOOD RED. A GREAT STORM WILL DARKEN THE SKY. AND LIKE IT IS WRITTEN IN JEREMIAH CHAPTER 24, THE JEWS ARE CALLED FIGS. AND AS WE ALL KNOW HOLLYWOOD IS WHERE THE STARS ARE. FURTHER MORE, THE EARTHQUAKE IN LOS ANGELES COUNTY WILL CAUSE HORIZONTAL DISPLACEMENT ON THE SAN ANDREAS FAULT AND THE MOUNTAINS AND ISLANDS WILL BE MOVED OUT OF PLACE. HALLELUJAH, AMEN, PRAISE THE LORD. THE HOLY BIBLE IS THE TRUTH, AMEN, PRAISE GOD, HALLELUJAH. JESUS IS LORD, JESUS IS GOD. WE LOVE GOD. AND THANKS BE TO GOD THAT THIS IS A JUDEO CHRISTIAN CAPITALIST DEMOCRACY, AMEN. 

SUP. ANTONOVICH, MAYOR: MISQUOTING THE BIBLE IS NOT IN THE BIBLE. 

DAVID SERRANO: THAT'S THE TRUTH. THAT'S THE TRUTH. THE HOLY BIBLE IS THE TRUTH. 

SUP. ANTONOVICH, MAYOR: BRING LOS ANGELES COUNTY WHERE IT'S SPECIFICALLY MENTIONED IN REVELATIONS, OTHERWISE YOU'RE JUST ACTING LIKE A FOOL. [COMMENTS OFF MIC]. MR. SACHS. 

ARNOLD SACHS: YOU PUT ME IN AN UNENVIABLE POSITION TO FOLLOW THE THUNLDER AND THE LIGHTNING. BUT IT IS WHAT IT IS. JUST A COUPLE NEWS STORIES THAT CAUGHT MY EYE RECENTLY. THIS WAS FROM SATURDAY REGARDING THE RESIGNATION OF THE GOVERNOR IN CALIFORNIA. IMPROPRIETY SURFACING. PILING UP AND JUST BRUSHING IT OFF. AND THEN THIS EDITORIAL FROM SUNDAY, FEBRUARY 15TH. AN EPIDEMIC OF MISCONDUCT ABOUT CRIMINAL PROSECUTORS WHO LIE OR HIDE EVIDENCE TO BOLSTER THEIR CASES. AND YEAH IT'S A STRETCH, SOMEHOW OR OTHER YOU COULD PUT COUNTY COUNSEL IN THERE AS ENABLING THE BOARD TO, LIKE THEY DID TODAY, STEP ON THE RIGHTS OF PEOPLE WHO HAVE COMMENT ON ITEMS ON THE AGENDA, YOU HAVE THREE ITEMS THAT YOU COMBINE AS ONE, AND YOU LIMIT PUBLIC INPUT ON ONE TO 1 MINUTE FOR THOSE THREE ITEMS. AND COUNTY COUNSEL SNORES RIGHT THROUGH IT. THERE WAS A COMMERCIAL ON DURING THE CHRISTMAS ON THE RADIO ABOUT THIS CAR DEALERSHIP THAT MADE THIS SPECTACULAR OFFER. AND THE PUNCH LINE WAS: THEY WOULD SAY MORE, BUT THEN THEY'D HAVE TO WAKE THEIR LAWYERS UP. SO I'M WONDERING IF COUNTY COUNSEL WAS MOONLIGHTING. BUT HOW DOES IT KEEP ROLLING ALONG, THAT PUBLIC INPUT, PUBLIC PARTICIPATION IS JUST STOMP ON IN THE LARGEST COUNTY IN THE COUNTRY, LIKE YOU'RE AFRAID OF SOMETHING. AND REALLY QUICK. "THE V.A. DETAILS PLANS TO HOUSE VETS." THEY HAVE AN ACTION PLAN. AN ACTION PLAN, THE C.D.B.G. FUNDS. YEAH, ROLL OVER 16 MILLION. ACTION, ACTION, ACTION. COUNTY COUNSEL. 

OSCAR MOHAMMED: MY NAME IS OSCAR MOHAMMED. I SPEAK FOR THE OPPRESSED. I SPEAK FOR THE STRUGGLING POOR. I SPEAK A LITTLE ABOUT RELIGION. THIS IS BLACK HISTORY MONTH. DR. WILSON FOUNDED BLACK HISTORY. HE WAS A BLACK HISTORIAN. HE WROTE MANY ENCYCLOPEDIAS ABOUT BLACK HISTORY AND BLACK CONTRIBUTION TO AMERICA. BUT THE TRUE AMERICA GOVERNMENT IS ISLAM GOVERNMENT. THE MUSLIM WAS FIRST. THE FIRST PRESIDENT OF UNITED STATES OF AMERICA WAS A MUSLIM. HE WAS AN AFRICAN FROM LIBERIA. JULY 4, 1776, PRESIDENT JOHN [INUAIDLBE] WROTE THE ELECTRIC DECLARATION OF INDEPENDENCE. AS WAS IN THE BEGINNING SO IT SHALL BE IN THE END. TODAY WE HAVE A PRESIDENT, TODAY IS AN AFRICAN OUR LAST PRESIDENT TODAY, HE WAS A MUSLIM AND HE'S AN AFRICAN. BUT I'D LIKE TO TALK ABOUT OUR RESPONSIBILITY IN OUR GOVERNMENT, THOUGH. WE SHOULD END CORRUPTION IN GOVERNMENT. AMERICA WOULD BE A MUCH BETTER LAND IF WE CAN LIVE BY THE CONSTITUTION THAT GOVERN US. THE FOUNDING FATHERS OF AMERICA, PRESIDENT JOHN ADAMS, HE SAID THAT DEMOCRACY SHOULD NEVER RULE OVER MORALS. WE LIVE IN A COUNTRY THAT -- I THROW MY THOUGHTS AWAY, THOUGH. BUT ANYWAY, SEPARATE BUT EQUAL. NO RACE SHOULD HAVE AUTHORITY OVER ANOTHER RACE. BUT WE FIND TODAY THAT MORE ERRORS OR FAILURE POINT TO THE BLACK AMERICA THAN OTHER RACE. BUT PHARAOH RULED THE SAME WAY, HE DESTROYED THE MALES AND LET THE FEMALE USED FOR HIS PURPOSE. BUT SEEMED LIKE THE LAST PROPHET, THE QUR'AN IS THE BOOK THAT MOHAMMED BROUGHT AND THE CONSTITUTION OF THE UNITED STATES COME FROM THE QUR'AN. AND ALSO IN THE CONSTITUTION IT SAY IN ORDER TO FORM A MORE PERFECT UNION. AND EVERYTHING PROPHET MOHAMMED DID, HE PERFECTED IT. AND THE FAREWELL ADDRESS, THE LAST FAREWELL ADDRESS THE PROPHET MOHAMMED MADE, AND TODAY WE HAVE THE SPEECHES THE FAREWELL ADDRESS OF THE PRESIDENTS. 

SUP. ANTONOVICH, MAYOR: REWRITE THE CONSTITUTION. REWRITE THE BIBLE. OKAY. 

LORAYNE LINGAT, DPTY. EXEC. OFCR.: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM CS-1, CONFERENCE WITH LEGAL COUNSEL REGARDING SIGNIFICANT EXPOSURE TO LITIGATION; ITEM NO. CS-2, DEPARTMENT HEAD PERFORMANCE EVALUATIONS AS INDICATED ON THE POSTED AGENDA. 

I, JENNIFER A. HINES, Certified Shorthand Reporter Number 6029/RPR/CRR qualified in and for the State of California, do hereby certify:

     That the transcripts of proceedings recorded by the Los Angeles County Board of Supervisors February 17, 2015,

were thereafter transcribed into typewriting under my direction and supervision;

     That the transcript of recorded proceedings as archived in the office of the reporter and which have been provided to the Los Angeles County Board of Supervisors as certified by me.

     I further certify that I am neither counsel for, nor related to any party to the said action; nor

in anywise interested in the outcome thereof.

    
 IN WITNESS WHEREOF, I have hereunto set my hand this 23rd day of February 2015, for the County records to be used only for authentication purposes of duly certified transcripts      

as on file of the office of the reporter.

                   

JENNIFER A. HINES 

          

   CSR No. 6029/RPR/CRR

0
89

